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Prima di usare la calcolatrice

Leggere prima questa sezione

Informazioni su questo manuale
• In nessun caso CASIO Computer Co., Ltd. sarà responsabile nei

confronti di terzi per danni speciali, collaterali, incidentali o conseguenti,
in connessione con, o aventi origine da, l’acquisto o l’uso di questo
prodotto e degli articoli che lo accompagnano. Inoltre, CASIO Computer
Co., Ltd. non sarà responsabile per rivendicazioni di qualsiasi tipo,
provenienti da qualsiasi altra parte contraente, e aventi origine dall’uso
di questo prodotto e degli articoli che lo accompagnano.

• Il contenuto di questo manuale è soggetto a modifiche senza preavviso.
• Le schermate e le illustrazioni (come ad esempio le indicazioni sui

tasti) mostrate in questo manuale sono fornite solo a scopo illustrativo
e possono differire parzialmente rispetto agli elementi effettivi che
rappresentano.

• QR Code è un marchio registrato di DENSO WAVE INCORPORATED in
Giappone e in altri Paesi.

• I nomi di aziende e prodotti utilizzati in questo manuale possono essere
marchi o marchi registrati dei rispettivi titolari.

Effetti dei tasti
Il seguente esempio mostra come sono rappresentate le pressioni dei tasti
in questo manuale.

Esempio 1: 
I tasti devono essere premuti nella sequenza mostrata sopra (da sinistra a
destra).

Esempio 2: (π)*
La sequenza riportata sopra indica che è necessario premere , quindi

, per inserire il simbolo π. Tutte le operazioni di inserimento con più
tasti sono indicate in questo modo. Sono visualizzate funzioni principali dei
tasti, seguite dal carattere da inserire o dal comando tra parentesi.
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* Fare riferimento alla sezione “Indicazioni sui tasti” (pagina 15) per
ulteriori informazioni sui simboli dei tasti utilizzati in questo esempio.

Esempio 3: , , , , , 

• I singoli tasti cursore indicati da (1) sono rappresentati come , , ,
.

• I singoli tasti per lo scorrimento della pagina indicati da (2) sono
rappresentati come , .

Operazioni nei menu
Per alcune operazioni di questo manuale si usa una forma semplificata
delle operazioni svolte dei menu, come mostrato negli esempi seguenti.

Esempio 1

 – [Other] > [π]

oppure

Premere , quindi selezionare [Other] > [π].

Operazione effettiva 1

1. Premere .
2. Utilizzando  e , selezionare [Other], quindi premere .
3. Utilizzando  e , selezionare [π], quindi premere .
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Esempio 2

 - Calculate

oppure

Premere , selezionare l’icona dell’app Calculate, quindi premere .

Operazione effettiva 2

1. Premere .
2. Con i tasti cursore ( , , , ), selezionare l’icona dell’app

Calculate, quindi premere .

Tasto  e tasto 
Il tasto  e il tasto  eseguono la stessa operazione. In questo manuale
si usa  per selezionare o applicare un’impostazione, mentre  viene
utilizzato per eseguire i calcoli. Tuttavia è indifferente premere  o  per
le operazioni in cui è mostrato  o .

Esempi
Se non si richiede di utilizzare una specifica app della calcolatrice o di
configurare impostazioni particolari per un esempio, vengono utilizzate
l’app e le impostazioni riportate di seguito.

App della calcolatrice: Calculate
Impostazioni: impostazioni iniziali predefinite della calcolatrice

Per informazioni su come ripristinare le impostazioni iniziali predefinite
della calcolatrice, consultare la sezione “Inizializzazione della
calcolatrice” (pagina 8).

Inizializzazione della calcolatrice

Importante!

• La seguente procedura consente di inizializzare tutte le impostazioni della calcolatrice,
tranne Contrast e Auto Power Off. Cancella anche tutti i dati memorizzati nella
memoria della calcolatrice.

1. Premere  per visualizzare la schermata HOME.
2. Con i tasti cursore ( , , , ), selezionare l’icona di un’app della

calcolatrice, quindi premere .
3. Premere , quindi selezionare [Reset] > [Initialize All] > [Yes].

• Viene visualizzata la schermata HOME.
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Schermata “Get Started” della
calcolatrice
Quando è visibile la schermata HOME, premendo il tasto  verrà
visualizzata la schermata “Get Started”, che contiene le seguenti
informazioni.
• QR Code per accedere alla pagina web “Get Started” di Worldwide

Education Service (https://wes.casio.com/calc/cw/)
Nella pagina Get Started è possibile accedere alla Guida dell’utilizzatore
e ad altre e ad altre informazioni correlate per iniziare a utilizzare la
calcolatrice.

• Codice ID della calcolatrice (stringa di 24 caratteri)

Premere  per tornare alla schermata HOME.

Nota

• Si può visualizzare la schermata Get Started anche selezionandola dal menu
SETTINGS. Consultare la sezione “Utilizzo del menu SETTINGS” (pagina 21).

Precauzioni

Precauzioni di sicurezza
Grazie per aver acquistato questo prodotto CASIO.
Leggere le “Precauzioni di sicurezza” prima di utilizzare questo prodotto
per avere la certezza di usarlo correttamente. Conservare l’intera
documentazione dell’utente a portata di mano per riferimenti futuri.
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Pericolo
Indica qualcosa che crea il rischio maggiore di morte o lesioni
fisiche gravi.

 Avvertenze sulle pile di tipo a bottone e di tipo a moneta
(solo fx-991CW)

Prestare attenzione per garantire che una pila non venga
inghiottita accidentalmente.
Particolare attenzione si richiede per tenere le pile lontano
dalla portata dei bambini.

Se una pila dovesse essere inghiottita accidentalmente, o se c’è una
possibilità che una pila sia stata inghiottita, consultare immediatamente
un medico.
Inghiottendo una pila può avere come conseguenza ustioni chimiche,
penetrazione del tessuto mucoso, e altri gravi problemi che creano il
rischio di morte.

Avvertimento
Indica qualcosa che crea il rischio di morte o lesioni fisiche gravi.

 Schermo del display

Non premere il display LCD o sottoporlo ad un forte impatto.

In tal modo si può causare la frattura del vetro del display LCD, creando
il rischio di lesioni personali.

Se il display LCD dovesse rompersi, non toccare mai nessun
liquido all’interno.

Il liquido del display LCD venendo a contatto con la pelle, crea il rischio
di irritazione della pelle.
Se il liquido del display LCD dovesse venire a contatto con la bocca,
sciacquare immediatamente la bocca e consultare un medico.
Se il liquido del display LCD dovesse venire a contatto con gli occhi o la
pelle, sciacquare immediatamente con acqua pulita e quindi consultare
un medico.
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 Avvertenze sulle pile

Se il fluido fuoriuscito da una pila dovesse venire a contatto
con la pelle o indumenti, sciacquare immediatamente con
acqua pulita.

Il fluido delle pile venendo a contatto con gli occhi crea il rischio di
perdita della vista, ecc. Sciacquare immediatamente gli occhi e quindi
consultare un medico.

Attenzione
Indica qualcosa che crea il rischio di lesioni fisiche minori o danni
materiali.

Osservare le avvertenze riportate di seguito. La mancata
osservanza può causare la rottura di una pila, causando il rischio
di incendio, lesioni personali, e la contaminazione degli oggetti
nelle vicinanze con il fluido fuoriuscito.

• Non tentare mai di smontare una pila e non consentire mai il
cortocircuito di una pila.

• Non caricare una pila di tipo non ricaricabile.
• Non esporre una pila al calore o gettarla nel fuoco.

• Utilizzare solo il tipo di pila specificato.
• Inserire una pila con le sue polarità (più (+) e meno (–)) rivolte

correttamente.
• Sostituire la pila non appena possibile dopo il suo esaurimento.

 Avvertenze sulle pile

Rispettare le precauzioni seguenti. Il loro mancato rispetto
può causare l’esplosione della pila o la perdita di liquidi o
gas infiammabili.

• Utilizzare solo il tipo di pila specificato per questo prodotto.
• Non bruciare una pila né smaltirla in un inceneritore, né tramite taglio

o schiacciamento meccanico.
• Non sottoporre una pila a temperature eccessivamente elevate o

basse durante l’utilizzo, la conservazione o il trasporto.
• Non sottoporre una pila a pressione barometrica eccessivamente

bassa durante l’utilizzo, la conservazione o il trasporto.
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Precauzioni per la manipolazione
• fx-570CW: anche se la calcolatrice funziona normalmente, sostituire la

batteria almeno una volta ogni due anni (R03).
fx-991CW: anche se la calcolatrice funziona normalmente, sostituire la
batteria almeno una volta ogni due anni (LR44).
Una batteria scarica può perdere liquidi, danneggiando la calcolatrice
e causando malfunzionamenti. Non lasciare mai nella calcolatrice una
batteria scarica. Non cercare di utilizzare la calcolatrice quando la
batteria è completamente scarica (fx-991CW).

• I malfunzionamenti e i danni dovuti a perdite di liquidi dalla batteria non
sono coperti dalla garanzia; i relativi costi verranno addebitati.

• La batteria fornita con la calcolatrice si scarica leggermente durante
le fasi di spedizione e stoccaggio. Potrebbe quindi essere necessario
sostituirla prima del previsto.

• Non utilizzare e non conservare la calcolatrice in aree soggette a
temperature estreme e in presenza di grandi quantità di umidità e
polvere.

• Non sottoporre la calcolatrice a impatti, pressioni o flessioni di intensità
eccessiva.

• Non cercare mai di smontare la calcolatrice.
• Pulire le parti esterne della calcolatrice con un panno morbido e

asciutto.
• Smaltire la calcolatrice e le batterie rispettando le leggi e i regolamenti

locali.

Per iniziare

Installazione e rimozione del coperchio anteriore

Rimozione del coperchio anteriore

Prima di utilizzare la calcolatrice, rimuovere il coperchio anteriore (①) e
fissarlo alla parte posteriore (②).
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Fissaggio del coperchio anteriore

Quando non si utilizza la calcolatrice, rimuovere il coperchio anteriore (①)
e applicarlo alla parte anteriore (②).

13



Importante!

• Applicare sempre il coperchio anteriore alla calcolatrice, ogni volta che non la si
utilizza. In caso contrario, la pressione accidentale del tasto  può determinare
l’accensione della calcolatrice, scaricando batteria.

Accensione e spegnimento
Premere  per accendere la calcolatrice.
Premere  (OFF) per spegnere la calcolatrice.

Nota

• Per accendere la calcolatrice, tenere premuto . Per evitare di accendere la
calcolatrice involontariamente la parte superiore del tasto  è leggermente più bassa
rispetto agli altri tasti.

• Se subito dopo l’accensione viene visualizzata la seguente schermata, la batteria è
scarica.

Se viene visualizzata questa schermata, sostituire la batteria appena possibile. Per
i dettagli sulla sostituzione della batteria, consultare la sezione “Sostituzione della
batteria” (pagina 147).
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• Inoltre, la calcolatrice si spegnerà automaticamente dopo circa 10 minuti o 60 minuti di
inutilizzo. Premere il tasto  per riaccendere la calcolatrice.

Schermata HOME
Premendo  viene visualizzata la schermata HOME. La schermata
HOME mostra l’elenco delle app installate sulla calcolatrice.

  Schermata HOME   Schermata dell’app
Calculate

                 
Per informazioni sulle app installate, consultare la sezione “Elenco delle
app installate sulla calcolatrice” (pagina 19).

Regolazione del contrasto del display
1. Premere , selezionare l’icona dell’app, quindi premere .
2. Premere , quindi selezionare [System Settings] > [Contrast].

3. Con  e , regolare il contrasto del display.
4. Una volta raggiunta l’impostazione desiderata, premere .

Importante!

• Se anche regolando il contrasto del display la leggibilità non migliora, probabilmente la
batteria è quasi scarica. Sostituire la batteria.

Indicazioni sui tasti
Premendo il tasto  seguito da un secondo tasto si attiva la funzione
alternativa del secondo tasto. La funzione alternativa è indicata dal testo
presente nella parte superiore sinistra del tasto.

(1) Funzione principale: 
(2) Funzione alternativa: (π)
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Indicatori
Indicatori

La tabella seguente descrive gli indicatori visualizzati nella parte superiore
della schermata.

Indicatore: Significato:

Il tastierino è stato rimosso premendo il
tasto . Il tastierino tornerà in posizione e
l’indicatore scomparirà premendo un tasto.

Il valore MathI/MathO o MathI/DecimalO è
selezionato per il parametro Input/Output nel
menu SETTINGS.

 /  / 
Impostazione attuale del parametro Angle Unit
( : Degree, : Radian oppure : Gradian) nel
menu SETTINGS.

FIX È attivo un numero fisso di posizioni decimali.

SCI È attivo un numero fisso di cifre significative.

E
Il valore On è stato selezionato per il parametro
Engineer Symbol nel menu SETTINGS.

i / ∠ Impostazione attuale del parametro Complex
Result (i : a+bi o ∠: r∠θ) nel menu SETTINGS.

 / 

Per il risultato del calcolo attualmente
visualizzato è disponibile una cronologia
precedente ( ) o successiva ( ). In alcune
app della, questi indicatori indicano che sono
disponibili altri risultati per il calcolo.
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La calcolatrice è alimentata direttamente dalle
celle solari, che possono essere l’unica fonte di
alimentazione o fungere da complemento alla
batteria (solo fx-991CW).

Utilizzo dei menu
Molte operazioni della calcolatrice si eseguono nelle schermate dei menu.
L’esempio seguente mostra le operazioni eseguibili nella schermata di
menu viene visualizzata quando si preme .

Selezione di una voce del menu

Per selezionare una voce del menu, evidenziarla con i tasti cursore ( ,
, , ), quindi premere . Nota:  e  si usano solo quando sono

presenti più colonne di voci del menu.

Navigazione tra le gerarchie dei menu

Il simbolo “ ” a destra di una voce del menu indica che sotto quella
voce esistono livelli gerarchici inferiori. Selezionando la voce di menu e
premendo  o  si passa al livello gerarchico inferiore. Per tornare al
livello superiore, premere .

Nota

• Se ci si trova in un livello gerarchico inferiore di un menu a una sola colonna, è anche
possibile premere , oltre a , per tornare al livello superiore.
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Selezione di una voce di menu con un pulsante di opzione
( / )

Quando sul display vengono visualizzate più opzioni, a sinistra di ciascuna
di esse sarà visibile un pulsante di opzione (  o ).  indica l’opzione
attualmente selezionata.

Configurazione dell’impostazione di un pulsante di opzione
1. Evidenziare la voce di menu desiderata e premere .

• La procedura dipende dal tipo di voce di menu selezionata.
- Se la voce di menu selezionata non prevede altre impostazioni da

configurare, il pulsante di opzione cambierà in .
- Se la voce di menu selezionata ha più impostazioni da configurare

verrà visualizzata una schermata che consente di selezionare
l’impostazione desiderata. In questo caso, passare alla fase 2.

2. Nella schermata delle impostazioni, evidenziare l’opzione desiderata e
premere .
• Si tornerà così alla schermata della voce di menu della fase 1, dove

il pulsante di opzione accanto alla voce precedentemente selezionata
avrà assunto questo aspetto: .

Scorrimento tra le schermate

Quando le voci del menu sono molte e non entrano in una sola schermata,
sul lato destro del display appare una barra di scorrimento.
• Utilizzare  e  per scorrere tra le schermate.
• Utilizzare  e  per scorrere le righe una dopo l’altra.

Chiusura di un menu e ritorno alla schermata visualizzata in
precedenza

Premere .

Nota

• È possibile chiudere il menu visualizzato premendo , , , , , 
oppure premendo . Se il menu visualizzato è uno di quelli che appaiono
immediatamente dopo l’avvio di un’app della calcolatrice o se è un menu specifico
di un’app, non è possibile chiuderlo premendo . In questo caso per chiudere il
menu è necessario premere .
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App e menu della calcolatrice

App della calcolatrice

Selezione di un’app della calcolatrice
Selezionare un’app adeguata al tipo di calcolo da eseguire.
1. Premere  per visualizzare la schermata HOME.

• Per informazioni su ciascuna app della calcolatrice, consultare la
sezione “Elenco delle app installate sulla calcolatrice” (pagina
19).

2. Con i tasti cursore ( , , , ) selezionare l’icona di un’app della
calcolatrice.

3. Premere  per visualizzare la schermata iniziale dell’app selezionata.

Elenco delle app installate sulla calcolatrice

Icona Descrizione

(Calculate)

Calcoli generali

(Statistics)

Calcoli statistici e di regressione

(Distribution)

Calcoli di distribuzione
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(Spreadsheet)

Calcoli in fogli di calcolo

(Table)

Genera una tabella di numeri basata
su una o due funzioni

(Equation)

Equazioni simultanee, equazioni di
ordine superiore e Solver (funzione
che consente di ricavare il valore
di qualsiasi variabile contenuta in
un’equazione inserita)

(Inequality)

Calcolo disuguaglianza

(Complex)

Calcolo di numeri complessi

(Base-N)

Calcoli su specifici sistemi
numerici (binario, ottale, decimale,
esadecimale)

(Matrix)

Calcoli nelle matrici

(Vector)

Calcoli vettoriali
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(Ratio)

Calcolo di proporzioni

(Math Box)

Le seguenti funzioni supportano
l’apprendimento della matematica.
Dice Roll, Coin Toss: Simulazione
delle probabilità

Utilizzo del menu SETTINGS
Per visualizzare il menu SETTINGS, premere  mentre è in uso un’app
della calcolatrice. Il menu SETTINGS contiene le voci riportate di seguito.

Calc Settings
Contiene le voci per la configurazione delle
impostazioni di calcolo, come il formato di
visualizzazione del risultato.

System Settings
Contiene le voci per la configurazione delle
impostazioni operative della calcolatrice, come la
regolazione del contrasto.

Reset
Contiene le voci per l’esecuzione di vari tipi di
operazioni di ripristino.

Get Started

Consente di Visualizzare la schermata Get
started. Per ulteriori informazioni, consultare
la sezione “Schermata “Get Started” della
calcolatrice” (pagina 9).

Nota

• Premendo  mentre è visualizzata la schermata HOME, verrà visualizzata la
schermata Get Started anziché il menu SETTINGS.

• A seconda della schermata visualizzata nell’app, premendo  potrebbe non apparire
il menu SETTINGS.
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Modifica delle impostazioni della calcolatrice
1. Premere , selezionare l’icona dell’app, quindi premere .
2. Premere  per visualizzare il menu SETTINGS.

3. Con  e , selezionare Calc Settings o System Settings, quindi
premere .
• Viene visualizzato l’elenco delle voci di impostazione del menu

selezionato.
La schermata riportata qui mostra un esempio di cosa viene
visualizzato selezionando [Calc Settings].

• Consultare la sezione “Voci e opzioni disponibili per le
impostazioni” (pagina 22) per informazioni sulle voci presenti in
[Calc Settings] e [System Settings].

4. Con  e , evidenziare l’elemento da modificare, quindi premere .
• Verrà visualizzato un elenco di impostazioni disponibili per l’elemento

selezionato.
La schermata riportata qui mostra un esempio di cosa viene
visualizzato selezionando [Input/Output].

5. Con  e , evidenziare l’opzione desiderata, quindi premere .
6. Una volta raggiunta l’impostazione desiderata, premere .

Voci e opzioni disponibili per le impostazioni
“◆” indica l’impostazione predefinita iniziale.

Calc Settings > Input/Output

Consente di specificare il formato da utilizzare per l’inserimento
dell’espressione e per la visualizzazione del risultato del calcolo.
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MathI/MathO◆ Inserimento: formato naturale tipo
libro di testo; visualizzazione
risultato: formato comprendente
una frazione, √  e/o π*1

MathI/DecimalO

Inserimento: formato naturale tipo
libro di testo; visualizzazione
risultato: conversione in valore
decimale

LineI/LineO
Inserimento: lineare*2;
visualizzazione risultato: decimale
o frazione

LineI/DecimalO
Inserimento: lineare*2;
visualizzazione risultato:
conversione in valore decimale

*1 L’uscita decimale si applica quando per qualche motivo questi formati
non sono utilizzabili.

*2 Tutti i calcoli, comprese le frazioni e le funzioni, si inseriscono in
un’unica riga. Stesso formato di visualizzazione dei modelli senza testo
naturale (modelli S-V.P.A.M. ecc.)

Esempi di formato di inserimento e di visualizzazione del risultato:

MathI/MathO
(impostazione predefinita iniziale)

MathI/DecimalO
(Number Format: Norm 1)

(Number Format: Norm 2)

LineI/LineO

LineI/DecimalO
(Number Format: Norm 1)
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Calc Settings > Angle Unit

Degree◆; Radian; Gradian
Consente di specificare il grado, il radiante o il gradiante come unità
di misura angolare per l’inserimento dei valore e la visualizzazione dei
risultati del calcolo.

Calc Settings > Number Format

Consente di specificare il numero di cifre per la visualizzazione dei risultati
del calcolo.
Fix: il valore specificato (da 0 a 9) determina il numero di posizioni
decimali per la visualizzazione dei risultati del calcolo. I risultati del calcolo
vengono arrotondati alla cifra specificata, prima di essere visualizzati.

Esempio: 1 ÷ 6
(Fix 3)

1 6 ( )*

Sci: il valore specificato (da 1 a 10) determina il numero di cifre
significative per la visualizzazione dei risultati del calcolo. I risultati
del calcolo vengono arrotondati alla cifra specificata, prima di essere
visualizzati.

Esempio: 1 ÷ 6
(Sci 3)

1 6 ( )*

Norm: consente di visualizzare i risultati del calcolo in formato
esponenziale, se rientrano negli intervalli riportati di seguito.
Norm 1◆: 10-2 > |x|, |x| ≥ 1010, Norm 2: 10-9 > |x|, |x| ≥ 1010

Esempio: 1 ÷ 200
(Norm 1)

1 200 ( )*

(Norm 2)
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1 200 ( )*

* Premendo ( ) anziché  dopo aver inserito un calcolo, il risultato
verrà visualizzato in formato decimale.

Calc Settings > Engineer Symbol

On; Off◆
Consente di specificare se visualizzare i risultati del calcolo utilizzando i
simboli scientifici.

Nota

• Se per questa impostazione è selezionata l’opzione On, nella parte superiore dello
schermo viene visualizzato l’indicatore (E).

Calc Settings > Fraction Result

Mixed Fraction; Improp Fraction◆
Consente di specificare una frazione mista o una frazione impropria per la
visualizzazione delle frazioni nei risultati del calcolo.

Calc Settings > Complex Result

a+bi◆; r∠θ
Consente di specificare le coordinate cartesiane o le coordinate polari
per le soluzioni polinomiali nei risultati del calcolo delle app Complex e
Equation.

Nota

• Se per l’impostazione Complex Result è selezionata l’opzione a+bi, nella parte
superiore dello schermo viene visualizzato l’indicatore i. Se è selezionato r∠θ, viene
visualizzato ∠.

Calc Settings > Decimal Mark

Dot◆; Comma
Consente di specificare se visualizzare un punto o una virgola come
separatore dei decimali nel risultato del calcolo. Durante l’inserimento
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viene sempre visualizzato un punto. Quando come separatore dei decimali
è selezionato il punto, se sono presenti più risultati essi saranno separati
da una virgola (,). Quando è selezionata la virgola, i risultati sono separati
da un punto e virgola (;).

Calc Settings > Digit Separator

On; Off◆
Consente di specificare se utilizzare o un separatore nei risultati del
calcolo.

System Settings > Contrast

Consultare la sezione “Regolazione del contrasto del display” (pagina
15).

System Settings > Auto Power Off

10 Min.◆; 60 Min.
Consente di specificare l’intervallo oltre il quale si attiva la funzione Auto
Power Off.

System Settings > MultiLine Font

Normal Font◆; Small Font
Consente di specificare le dimensioni del carattere visualizzato quando si
seleziona LineI/LineO o LineI/DecimalO per Input/Output. Se si seleziona
Normal Font è possibile visualizzare fino a quattro righe, mentre con Small
Font se ne possono visualizzare fino a sei.

System Settings > QR Code

Consente di specificare la versione di QR Code visualizzata quando si
preme (QR).
Version 3: Indica la versione 3 di QR Code.
Version 11◆: Indica la versione 11 di QR Code.

Reset > Settings & Data

Consultare la sezione “Inizializzazione delle impostazioni della
calcolatrice” (pagina 27).

26



Reset > Variable Memory

Consultare la sezione “Cancellazione del contenuto di tutte le
memorie” (pagina 41).

Reset > Initialize All

Consultare la sezione “Inizializzazione della calcolatrice” (pagina 8).

Get Started

Consultare la sezione “Schermata “Get Started” della calcolatrice”
(pagina 9).

Inizializzazione delle impostazioni della calcolatrice

Importante!

• La seguente procedura consente di inizializzare tutte le impostazioni della calcolatrice,
tranne Contrast e Auto Power Off. Cancella anche tutti i dati, tranne i dati della
memoria delle variabili e di Ans.

1. Premere , selezionare l’icona dell’app, quindi premere .
2. Premere , quindi selezionare [Reset] > [Settings & Data] > [Yes].

• Viene visualizzata la schermata HOME.

Utilizzo del menu CATALOG
Premere  per visualizzare il menu CATALOG. In questo menu sono
visualizzate le categorie dei comandi, delle funzioni e dei simboli in base
all’app della calcolatrice in uso e allo stato attuale (schermata visualizzata
o impostazioni attuale) dell’app.

Esempio: menu CATALOG dell’app Calculate

Nota

• Per informazioni su come inserire i comandi, le funzioni e i simboli dal menu
CATALOG, consultare la sezione “Calcoli avanzati” (pagina 49).
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• Per informazioni su comandi, funzioni e simboli specifici di ciascuna app, consultare
le descrizioni delle app nella sezione “Utilizzo delle app della calcolatrice” (pagina
69).

Utilizzo del menu TOOLS
Il menu TOOLS, viene visualizzato premendo , contiene opzioni che
consentono di eseguire funzioni specifiche per ogni app della calcolatrice
e per configurare le impostazioni.

Esempio: menu TOOLS per l’app Calculate

Esempi: menu TOOLS per l’app Table

Nota

• La seguente voce di menu è condivisa da diverse app della calcolatrice.
- Undo (consultare la sezione “Annullamento delle operazioni” (pagina 31).)
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Inserimento di espressioni e
valori

Regole per l’inserimento di base
Quando si preme  la sequenza della priorità del calcolo verrà valutata
automaticamente e il risultato sarà visualizzato sul display.

4 × sin 30 × (30 + 10 × 3) = 120

*1 La parentesi di chiusura è necessaria per la funzione sin e per altre
funzioni che includono le parentesi.

*2 Questi simboli di moltiplicazione (×) si possono omettere.
*3 La parentesi di chiusura immediatamente prima dell’operazione  si

può omettere.

Spostamento del cursore all’inizio o alla fine di
un’espressione inserita

Quando si inserisce un’espressione è possibile premere  per spostare
istantaneamente il cursore all’inizio dell’espressione o  per spostarlo alla
fine.

Indicatore “Altro” (  , ) per l’espressione inserita e il
risultato del calcolo

Se viene visualizzato un simbolo triangolare (  oppure ) nella parte
destra della riga di un’espressione inserita o della riga dei risultati di un
calcolo, significa che la riga visualizzata continua verso destra. Utilizzare

 e  per scorrere la riga verso sinistra e verso destra.
• Quando il simbolo  è visibile all’estremità destra della riga dei risultati

di un calcolo, è possibile passare alla parte finale del risultato premendo
. Per passare alla parte iniziale della riga dei risultati del calcolo,

premere .
• Nota: per scorrere l’espressione inserita mentre sono visualizzati

entrambi gli indicatori  e , è necessario premere prima  o ,
quindi scorrere con  e .
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Completamento automatico delle parentesi

Se si esegue un calcolo che comprende operazioni sia di divisione che
di moltiplicazione in cui un segno di moltiplicazione è stato omesso, le
parentesi vengono inserite automaticamente come mostrato nei seguenti
esempi.
- Quando viene omesso un segno di moltiplicazione immediatamente

prima di una parentesi aperta o dopo una parentesi chiusa.
Esempio: 6 ÷ 2(1 + 2) → 6 ÷ (2(1 + 2))

- Quando viene omesso un segno di moltiplicazione immediatamente
prima di una variabile, una costante ecc.
Esempio: 6 ÷ 2π → 6 ÷ (2π)

Indicazione limite in ingresso

Il cursore cambi aspetto in  quando rimangono 10 byte (o meno)
disponibili per l’inserimento. In tal caso, concludere l’inserimento del
calcolo e premere .

Inserimento di un’espressione in
formato naturale tipo libro di
testo (solo MathI/MathO o MathI/
DecimalO)
Le espressioni contenenti frazioni e/o funzioni speciali come √  si
possono inserire in formato naturale tipo libro di testo utilizzando i modelli
visualizzati quando si premono determinati tasti o quando si inseriscono
determinate funzioni tramite il menu CATALOG.

Esempio: 3 1
2  + 5 3

2
1. Premere ( ).

• Verrà inserito un modello di frazione mista.
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2. Inserire i valori nelle aree dei numeri interi, dei numeratori e dei
denominatori, nel modello.

3 1 2

3. Procedere allo stesso modo per inserire il resto dell’espressione.

( )5 3 2

Nota

• Quando il cursore si trova all’interno dell’area di inserimento di un modello (frazioni
miste, integrali (∫) e sommatoria (Σ)), premendo  si passa alla posizione
immediatamente successiva (a destra) del modello, mentre premendo  si passa
a quella immediatamente precedentemente (a sinistra).

• È sempre possibile individuare il cursore all’interno di un modello, perché l’area vuota
o i caratteri in cui si trova sono di colore nero. Tutto il resto dell’espressione è di colore
grigio scuro.

Annullamento delle operazioni
Per annullare l’ultima pressione di un tasto, premere , selezionare
[Undo], quindi premere .
Per rieseguire un’operazione appena annullata, premere , selezionare
[Undo] e premere nuovamente .

Utilizzo dei valori e delle espressioni come
argomenti

Esempio: inserire 1 + 7
6 , quindi cambiarlo in 1 + 

1 7 6 (INS)

Premendo (INS) nell’esempio precedente, 7
6  diventa l’argomento

della funzione inserita dalla successiva pressione del tasto (√ ).
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Modalità di inserimento con
sovrascrittura (solo LineI/LineO o
LineI/DecimalO)
In modalità di sovrascrittura, il testo inserito sostituisce il testo che si trova
nella posizione attuale del cursore. È possibile passare dalla modalità di
inserimento alla modalità di sovrascrittura e viceversa nel modo seguente:

(INS). Il cursore appare come “ ” in modalità di inserimento e come
“ ” in modalità di sovrascrittura.
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Calcoli fondamentali

Calcoli aritmetici
I tasti , ,  e  consentono di eseguire calcoli aritmetici.

Esempio: 7 × 8 - 4 × 5 = 36

7 8 4 5

Calcoli con le frazioni
Nota: il metodo di inserimento delle frazioni dipende dall’impostazione
Input/Output attuale nel menu SETTINGS.

Per inserire 7
3  (frazione impropria)

(Input/Output: MathI/MathO o MathI/DecimalO)

7 3 o 7 3 7
3

(Input/Output: LineI/LineO o LineI/DecimalO)

7 3

(a) Numeratore, (b) Denominatore

Per inserire 2 1
3  (frazione mista)

(Input/Output: MathI/MathO o MathI/DecimalO)

( )2 1 3 2 1
3

(Input/Output: LineI/LineO o LineI/DecimalO)
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2 1 3

(a) Numeratore, (b) Denominatore, (c) Parte intera

Esempio: 2
3  + 1 1

2  = 13
6

(Input/Output: MathI/MathO)

2 3 ( )1 1 2

(Input/Output: LineI/LineO)

2 3 1 1 2

Nota

• Nei risultati dei calcoli le frazioni vengono visualizzate dopo essere state ridotte ai
minimi termini.

Per convertire il formato di un risultato di calcolo in frazione impropria
o in frazione mista, premere . Per ulteriori informazioni, consultare
la sezione “Conversione di frazioni improprie e di frazioni miste”
(pagina 46).

Risultati dei calcolo in formato frazionario

Non è possibile visualizzare il risultato di un calcolo contenente un numero
totale di cifre in frazioni miste (compresi numero intero, numeratore,
denominatore e simbolo di separatore ) maggiore di 10. In questo caso il
risultato del calcolo viene visualizzato come valore decimale.

Esempio 1: 1 1 123456 = 123457 123456

(Input/Output: LineI/LineO)

1 1 123456

Poiché il numero totale di cifre del valore 1 1 123456 è 10, il risultato
viene visualizzato come valore frazionario.
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Esempio 2: 1 1 1234567 (= 1234568 1234567) = 1,00000081

(Input/Output: LineI/LineO)

1 1 1234567

Poiché il numero totale di cifre del valore 1 1 1234567 è 11, il risultato
viene visualizzato come valore decimale.

Nota

• Combinando valori frazionari e decimali in un calcolo quando si seleziona un valore
diverso da MathI/MathO, il risultato verrà visualizzato come valore decimale.

Potenze, radici e reciproci
Con i seguenti tasti si possono inserire potenze, radici e reciproci.
Potenze:  (quadrato),  (potenza na)
Radici:  (radice quadrata), ( ) (radice na)
Reciproci: ( )

Esempio 1: (52)3 = 15625

5 3

Esempio 2: (1 + 1)2+2 = 16

1 1 2 2

Esempio 3: √2 × 3 = 3√2 = 4,242640687...
(Input/Output: MathI/MathO)

2 3

(Input/Output: LineI/LineO)

2 3
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Esempio 4: 5√32 = 2
(Input/Output: MathI/MathO)

( ) 5 32

(Input/Output: LineI/LineO)

5 ( ) 32

Esempio 5: 10-1 = 1
10

(Input/Output: MathI/MathO)

10 ( )

Tasto  (potenza di 10)

Premere il tasto  equivale a premere . Entrambe le
operazioni consentono di inserire “×10 ” (MathI/MathO o MathI/DecimalO)
o “×10^(” (LineI/LineO o LineI/DecimalO).

Esempio: 1,23 × 103 = 1230

1 23 3

Intervalli di calcolo in formato √ 

Di seguito sono riportati Gli intervalli di visualizzazione consentiti per i
risultati dei calcoli in formato √ .

± a√b, ± d ± a√b, ± a√b
c  ± d√e

f
1 ≤ a < 100, 1 < b < 1000, 1 ≤ c < 100
0 ≤ d < 100, 0 ≤ e < 1000, 1 ≤ f < 100

Esempio:
• 10√2 + 15 × 3√3 = 45√3 + 10√2 ... Visualizzazione in formato √ 
• 99√999 (= 297√111) = 3129,089165 ... Visualizzazione come valore

decimale
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Pi greco, logaritmo naturale in base
e

Pi greco
Inserire π premendo (π).
π viene visualizzato come 3,141592654, anche se per i calcoli interni viene
utilizzato il valore π = 3,1415926535897932384626.

Logaritmo naturale in base e
Inserire e premendo (e).
Il logaritmo naturale in base e viene visualizzato come 2,718281828,
anche se per i calcoli interni viene utilizzato il valore e =
2,7182818284590452353602.

Cronologia dei calcoli e ripetizione

Cronologia dei calcoli
Il simbolo  e/o  nella parte superiore dello schermo indica ulteriore
contenuto della cronologia dei calcoli, sopra e/o sotto. Per scorrere il
contenuto della cronologia dei calcoli, utilizzare  e .

App che supportano la cronologia dei calcoli:
Calculate, Complex, Base-N

Esempio
2 + 2 = 4

2 2

3 + 3 = 6

3 3

(Consente di scorrere indietro.)
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Nota

• I dati della cronologia dei calcoli vengono tutti cancellati quando si preme  o ,
quando si modifica l’impostazione Input/Output e quando si esegue un’operazione di
Reset (“Settings & Data” o “Initialize All”).

Ripetizione
Quando è visibile il risultato di un calcolo, premendo ,  o  si può
modificare l’espressione utilizzata per il calcolo precedente.

Esempio
4 × 3 + 2 = 14

4 3 2

4 × 3 - 7 = 5

(Continua) 7

Nota

• Se viene visualizzato il simbolo  (sinistra) o  (destra) a entrambe le estremità
di una riga dei risultati di un calcolo, è possibile scorrere la riga verso sinistra e
verso destra utilizzando  e . In questo caso, premere prima  o , quindi
modificare l’espressione con  e .

Utilizzo delle funzioni di memoria

Memoria delle risposte (Ans)
Il risultato dell’ultimo calcolo ottenuto viene archiviato nella memoria Ans
(abbreviazione di “answer”, risposta).

Utilizzo della memoria Ans per eseguire una serie di calcoli

Esempio: dividere per 30 il risultato di 3 × 4

3 4
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(Continua) 30

Inserimento del contenuto della memoria Ans in
un’espressione

Esempio: eseguire i seguenti calcoli:

123 456

(Continua)  789

Variabili (A, B, C, D, E, F, x, y, z)
È possibile memorizzare i valori nelle variabili e utilizzare queste ultime nei
calcoli.

Schermata dell’elenco delle variabili

Premendo  viene visualizzata una schermata che mostra i valori
attualmente memorizzati in A, B, C, D, E, F, x, y e z. In questa schermata i
valori sono sempre visualizzati nel “Norm 1” Number Format. Per chiudere
la schermata, premere  o .

Esempio 1: memorizzare nella variabile A il risultato di 3 + 5
1. Eseguire il calcolo.

3 5

2. Premere , quindi selezionare [A=] > [Store].
• Il risultato di 3 + 5 (ovvero 8) viene memorizzato nella variabile A.

3. Premere .

39



Esempio 2: modificare il contenuto della variabile A in 1
1. Premere , quindi evidenziare [A=].

2. Premere .
• Viene visualizzata la schermata di modifica con 1 già inserito.

3. Premere .

Nota

• Anziché eseguire l’operazione citata al punto 2, è possibile premere  e selezionare
[Edit]. Viene visualizzata la schermata di modifica senza alcun valore inserito. Inserire
il valore e premere .

• Se viene visualizzata l’icona del lucchetto blocco ( ) quando si evidenzia
una variabile nella schermata dell’elenco delle variabili, significa che la variabile
evidenziata non è modificabile.

Esempio 3: richiamare il contenuto della variabile A
(continua dalla fase 2 dell’Esempio 1)
1. Premere , quindi selezionare [A=] > [Recall].

• Viene inserito il carattere “A”.

2. Premere .
• Viene richiamato il valore della variabile A.

Esempio 4: moltiplicare per 10 il contenuto della variabile A
(continua dalla fase 2 dell’Esempio 1)

40



(A)* 10

* Inserire una variabile come mostrato qui: premere , quindi premere il
tasto corrispondente al nome della variabile. Per inserire x come nome
della variabile, è possibile premere (x) o .

Cancellazione del contenuto di tutte le memorie
Il contenuto della memoria Ans e delle variabili viene conservato anche se
si preme , si passa a un’altra app o si spegne la calcolatrice.
La seguente procedura consente di cancellare il contenuto di tutte le
memorie.
1. Premere , selezionare l’icona dell’app, quindi premere .
2. Premere , quindi selezionare [Reset] > [Variable Memory] > [Yes].
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Modifica del formato dei
risultati dei calcoli

Utilizzo del menu FORMAT
Il menu FORMAT visualizzato quando si preme  consente di convertire
in vari formati il risultato del calcolo visualizzato.

Elenco menu FORMAT

Questa voce di menu:
Consente di convertire in questo
formato:

Standard
Standard (include frazioni, π, formati
√ )

Decimal Decimale

Prime Factor Scomposizione in fattori primi

Rectangular Coord Coordinate cartesiane

Polar Coord Coordinate polari

Improper Fraction Frazione impropria

Mixed Fraction Frazione mista

ENG Notation
Notazione scientifica (formato a×10n,
n = esponente divisibile per 3)

Sexagesimal
Gradi, minuti, secondi (sistema
sessagesimale)
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Nota

• Le voci del menu visualizzate quando si preme il pulsante  dipendono dal risultato
del calcolo visualizzato. Inoltre, se il risultato del calcolo visualizzato non può essere
convertito, premendo  il menu non verrà visualizzato.

Operazioni di conversione

Esempio: 3 ÷ 2 = 3
2  = 1,5 = 1 1

2
In questo esempio convertiremo il risultato del calcolo visualizzato come
frazione impropria in un valore decimale, quindi in una frazione mista.
Infine, annulleremo la conversione e torneremo al risultato originale.
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

1. Eseguire il calcolo 3 ÷ 2.

3 2

2. Per convertire il risultato del calcolo in un valore decimale, premere ,
selezionare [Decimal], quindi premere .

3. Per convertire il risultato del calcolo in una frazione mista, premere ,
selezionare [Mixed Fraction], quindi premere .

4. Per annullare la conversione, premere .
• Viene visualizzato il risultato del calcolo originale del passaggio 1.
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Conversione in formato Standard e
Decimal
Il formato Standard consente di visualizzare il risultato dei calcoli in modo
da includere frazioni, √  o π, when possible. Il formato Decimal consente di
visualizzare il risultato dei calcoli come valore decimale.

Nota

• La conversione al formato Standard comprendente √  o π è possibile se MathI/MathO
o MathI/DecimalO è stato selezionato per l’impostazione Input/Output nel menu
SETTINGS.

La seguente operazione consente di convertire il risultato di un calcolo nel
formato Standard o Decimal.

Esempio: π ÷ 6 = 1
6  π = 0,5235987756 (Input/Output: MathI/MathO)

(π) 6

(Selezionare [Decimal].)

(Conversione in un valore decimale.)

(Conversione nel formato Standard.)

Importante!

• Con i risultati di alcuni calcoli, selezionando [Standard] nel menu FORMAT, il valore
visualizzato non verrà convertito.
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Come ottenere il risultato di un calcolo del valore decimale
quando è selezionata l’opzione MathI/MathO o LineI/LineO

Premere ( ) anziché , dopo aver inserito un calcolo.

Scomposizione in fattori primi
L’app Calculate consente di scomporre in fattori primi un numero intero
positivo di non oltre 10 cifre.

Esempio: scomporre in fattori primi il numero 1014

1014

 – [Prime Factor]

Nota

• I valori con le caratteristiche descritte di seguito non si possono scomporre in fattori
primi, anche se contengono 10 cifre o meno.
- Uno dei fattori primi del valore è 1.018.081 o un numero superiore.
- Due o più dei fattori primi del valore cono composti da più di tre cifre.

• La parte non scomponibile in fattori primi è racchiusa tra parentesi sul display.
Esempio: 2036162 = 2 × (1018081)*

*1018081 = 10092

2036162
 – [Prime Factor]

Conversione di coordinate
cartesiane e polari
È possibile convertire il risultato di un calcolo di numeri complessi in
coordinate cartesiane (  – [Rectangular Coord]) o coordinate polari (  –
[Polar Coord]). Questa conversione si può eseguire nei seguenti casi.
• Mentre è visibile la soluzione di un’equazione di ordine superiore

dell’app Equation (purché sia stato selezionato il valore On per
l’impostazione  – [Complex Roots] dell’app Equation)

• Mentre è visibile il risultato di un calcolo dell’app Complex
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Per un esempio concreto di conversione, consultare le seguenti sezioni.
“Conversione di una soluzione di numeri complessi in coordinate
cartesiane o polari” (pagina 110)
“Conversione del risultato del calcolo di un numero complesso in
coordinate cartesiane o polari” (pagina 116)

Conversione di frazioni improprie e
di frazioni miste
È possibile convertire il valore frazionario o decimale attualmente
visualizzato (valore decimale convertibile in frazione da questa
calcolatrice) in una frazione mista o in una frazione impropria.

Esempio 1: 13
4  = 3 1

4
(Input/Output: MathI/MathO, Fraction Result: Improp Fraction)

13 4

 – [Mixed Fraction]

 – [Improper Fraction]

Esempio 2: 3,25 = 13
4  = 3 1

4  (Input/Output: LineI/LineO)

3 25

 – [Improper Fraction]

 – [Mixed Fraction]

Notazione scientifica
È possibile convertire la parte esponenziale del risultato di un calcolo
visualizzato in una potenza di dieci multipla di 3 e visualizzare il risultato.

Esempio: scrivere il valore 1234 in notazione scientifica spostando il
separatore dei decimali verso destra, quindi verso sinistra.
1. Inserire 1234, quindi premere .
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2. Con la seguente operazione, accedere alla modalità di conversione
ENG.

 – [ENG Notation]

• Passando alla modalità di conversione ENG, il risultato del calcolo
viene convertito in notazione scientifica e alla sua destra viene
visualizzato il simbolo .

• In modalità di conversione ENG è possibile usare  e  per
spostare il separatore dei decimali della mantissa.

3. Per uscire dalla modalità di conversione ENG, premere .
• Si uscirà dalla modalità di conversione ENG e il simbolo  sparirà dal

display.

• È possibile uscire dalla modalità di conversione ENG anche
premendo  o .

Nota

• In modalità di conversione ENG non si possono eseguire calcoli normali. Per iniziare
un nuovo calcolo, uscire dalla modalità di conversione ENG.

• La notazione scientifica si può visualizzare anche utilizzando i simboli scientifici. Per
informazioni dettagliate, consultare la sezione “Simboli scientifici” (pagina 59).
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Conversione sessagesimale (calcoli
di gradi, minuti, secondi)
È possibile convertire il risultato del calcolo di un valore decimale in un
valore sessagesimale.

Conversione del risultato del calcolo di un valore
decimale in un valore sessagesimale

Esempio: 1,25 = 1°15’0”

1 25

 – [Sexagesimal]

Inserimento e calcolo di valori sessagesimali
Oltre a convertire in formato sessagesimale il valore visualizzato, è
possibile inserire valori sessagesimali e utilizzarli nei calcoli.
Per l’inserimento dei valori sessagesimali si utilizza la seguente sintassi:

{gradi} ( ) {minuti} ( ) {secondi} ( )
Per i gradi e i minuti è sempre necessario inserire un valore, anche se si
tratta dello zero.

Esempio: calcolare 2°20’30” + 9’30”. Convertire quindi il risultato del
calcolo in un valore decimale.

2 ( )20 ( )30 ( )
0 ( )9 ( )30 ( )

(Conversione in un valore decimale.)
 – [Decimal]

(Tornare alla visualizzazione in formato
sessagesimale.)
 – [Sexagesimal]
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Calcoli avanzati
Questa sezione tratta i comandi, le funzioni e i simboli comuni a tutte
le app della calcolatrice. L’ordine in cui i comandi, le funzioni e i simboli
vengono presentati è lo stesso in cui sono visualizzati nel menu CATALOG
visualizzato quando si preme .

Nota

• Alcune voci del menu CATALOG specifici delle singole app non sono mostrati qui. Per
ulteriori informazioni sulle voci del menu specifiche per le singole app, consultare il
capitolo dedicato a ciascuna app della calcolatrice.

• A seconda dell’app in uso e della schermata visualizzata, potrebbe non essere
possibile inserire alcuni comandi, funzioni o simboli. I comandi, le funzioni e i simboli
che non si possono inserire non sono visibili nel menu CATALOG.

• I comandi, le funzioni e i simboli descritti qui non sono disponibili nell’app Base-N app.

Analisi di funzioni
Questa sezione tratta i comandi e le funzioni che si possono inserire dopo
aver eseguito l’operazione:  – [Func Analysis].

Derivative(d/dx)
La funzione Derivative(d/dx) consente di ottenere il coefficiente
differenziale approssimato della coordinata x-coordinate (a)
nell’espressione f(x) inserita.

Nota

• Questa funzione si può utilizzare con una delle seguenti app: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.

Sintassi dei valori inseriti

La sintassi dei valori inseriti dipende dall’impostazione Input/Output nel
menu SETTINGS, come mostrato nella tabella seguente.

Impostazione Input/Output Sintassi dei valori inseriti

MathI/MathO o MathI/DecimalO  d
dx (f(x))|x=a

49



LineI/LineO o LineI/DecimalO  d
dx (f(x), a, tol)*

* tol specifica la tolleranza, che vale 1 × 10-16 se non si inserisce nulla per
tol.

Precauzioni per il calcolo delle derivate

• Quando si utilizza una funzione trigonometrica in f(x), specificare
“Radian” come Angle Unit nel menu SETTINGS.

• Con un valore di tol inferiore si ottiene una maggiore precisione, ma
aumenta anche il tempo necessario per i calcoli. Quando si specifica il
parametro tol, inserire un valore uguale o superiore a 1 × 10-22.

• I seguenti elementi possono causare risultati imprecisi ed errori:
- Punti di discontinuità nei valori di x
- Variazioni estreme dei valori di x
- Inclusione del massimo locale e del minimo locale nei valori di x
- Inclusione del punto di flesso nei valori di x
- Inclusione di punti indifferenziati nei valori di x
- Risultati del calcolo differenziale vicini allo zero

Esempio di calcolo di derivate

Determinare f’( π
2 ) quando f(x) = sin(x) (valore di tol omesso)

(Input/Output: MathI/MathO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(π) 2

(Input/Output: LineI/LineO, Angle Unit: Radian)

 – [Func Analysis] > [Derivative(d/dx)]
(,) (π) 2

Integration(∫)
La calcolatrice calcola l’integrale utilizzando il metodo di integrazione di
Gauss-Kronrod.

Nota

• Questa funzione si può utilizzare con una delle seguenti app: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation, Inequality, Matrix, Vector, Ratio.
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Sintassi dei valori inseriti

La sintassi dei valori inseriti dipende dall’impostazione Input/Output nel
menu SETTINGS, come mostrato nella tabella seguente.

Impostazione Input/Output Sintassi dei valori inseriti

MathI/MathO o MathI/DecimalO

LineI/LineO o LineI/DecimalO

* tol specifica la tolleranza, che vale 1 × 10-10 se non si inserisce nulla per
tol.

Precauzioni per il calcolo integrale

• Quando si utilizza una funzione trigonometrica in f(x), specificare
“Radian” come Angle Unit nel menu SETTINGS.

• Con un valore di tol inferiore si ottiene una maggiore precisione, ma
aumenta anche il tempo necessario per i calcoli. Quando si specifica il
parametro tol, inserire un valore uguale o superiore a 1 × 10-22.

• In base al contenuto di f(x), ai valori positivi e negativi interni all’area
dell’integrale o all’area stessa, nel calcolo dell’integrale può verificarsi
un errore di grande entità. (Esempi: in presenza di parti con punti di
discontinuità o variazioni brusche, se l’intervallo di integrazione è troppo
grande.) In questi casi, dividendo l’intervallo di integrazione in più parti
prima di eseguire i calcoli si può aumentare la precisione.

Esempio di calcolo integrale

(ln(x), 1, e) = 1 (valore di tol omesso)

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Integration(∫)]
(ln) 1 (e)

(Input/Output: LineI/LineO)
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 – [Func Analysis] > [Integration(∫)]
(ln) (,)1 (,) (e)

Summation(Σ)
La funzione Σ( consente di ottenere la sommatori di un’espressione f(x)
per un intervallo specifico.

Nota

• Questa funzione si può utilizzare con una delle seguenti app: Calculate, Statistics,
Distribution, Spreadsheet, Table, Equation (tranne Solver), Inequality, Matrix, Vector,
Ratio.

Sintassi dei valori inseriti

La sintassi dei valori inseriti dipende dall’impostazione Input/Output nel
menu SETTINGS, come mostrato nella tabella seguente.

Impostazione Input/Output Sintassi dei valori inseriti

MathI/MathO o MathI/DecimalO

LineI/LineO o LineI/DecimalO

* a e b sono numeri interi che si possono specificare nell’intervallo -1 ×
1010 < a ≤ b < 1 × 1010.

Esempio di calcolo Σ

(x + 1) = 20

(Input/Output: MathI/MathO)

 – [Func Analysis] > [Summation(Σ)]
1 1 5

(Input/Output: LineI/LineO)

 – [Func Analysis] > [Summation(Σ)]
1 (,)1 (,)5
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Logarithm(logab), Logarithm(log)
Utilizzare (log) o  – [Func Analysis] > [Logarithm(log)] per inserire
logab come log (a, b). La base 10 è l’impostazione predefinita iniziale, se
non si inserisce nulla per a.

Esempio 1: log101000 = log 1000 = 3

(log)1000

Esempio 2: log216 = 4

(log)2 (,)16

Anche il tasto  (o  – [Func Analysis] > [Logarithm(logab)]) si può
utilizzare per l’inserimento, ma solo se MathI/MathO o MathI/DecimalO è
selezionato per il parametro Input/Output nel menu SETTINGS. In questo
caso è necessario inserire un valore per la base.

Esempio 3: log216 = 4

2 16

Natural Logarithm
Utilizzare (ln) o  – [Func Analysis] > [Natural Logarithm] per
inserire “ln”.

Esempio: ln 90 (= loge90) = 4,49980967

(ln)90

Probabilità
Questa sezione tratta i comandi e le funzioni che si possono inserire dopo
aver eseguito l’operazione:  – [Probability].
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%
Se si inserisce un valore seguito dal comando %, il valore diventa una
percentuale.

Nota

• Non è possibile inserire % con l’app Complex.

Esempio 1: 150 × 20% = 30

150 20
 – [Probability] > [%]

Esempio 2: calcolare quale percentuale di 880 è 660. (75%)

660 880
 – [Probability] > [%]

Esempio 3: scontare del 25% il valore 3500. (2625)

3500 3500 25
 – [Probability] > [%]

Factorial(!)
Questa funzione consente di calcolare il fattoriale del valore zero o di un
numero intero positivo.

Esempio: (5 + 3)! = 40320

5 3
 – [Probability] > [Factorial(!)]

Permutation(P), Combination(C)
Funzioni di permutazione (nPr) e combinazione (nCr).

Esempio: determinare il numero di possibili permutazioni e combinazioni
quando da un gruppo di 10 persone se ne selezionano quattro
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Permutazioni:

10
 – [Probability] > [Permutation(P)]

4

Combinazioni:

10
 – [Probability] > [Combination(C)]

4

Random Number
Questa funzione genera un numero pseudocasuale compreso tra 0,000 e
0,999. Il risultato è visualizzato come frazione se si seleziona MathI/MathO
per l’impostazione Input/Output nel menu SETTINGS.

Nota

• Non si può inserire Ran# con l’operazione Solver dell’app Equation.

Esempio: ottenere numeri casuali interi di tre cifre

1000
 – [Probability] > [Random Number]

(Il risultato varia a ogni esecuzione.)

Random Integer
Questa funzione genera un numero pseudocasuale intero compreso tra il
valore iniziale e il valore finale specificati.

Nota

• Non si può inserire RanInt# con l’operazione Solver dell’app Equation.

Esempio: generare numeri casuali interi compresi tra 1 e 6

 – [Probability] > [Random Integer]
1 (,)6

(Il risultato varia a ogni esecuzione.)
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Calcoli numerici
Questa sezione tratta i comandi e le funzioni che si possono inserire dopo
aver eseguito l’operazione:  – [Numeric Calc].

Absolute Value
Quando si esegue un calcolo numerico reale, cono questa funzione si
ottiene semplicemente il valore assoluto.

Esempio: |2 - 7| = Abs(2 - 7) = 5
(Input/Output: MathI/MathO)

 – [Numeric Calc] > [Absolute Value]
2 7

(Input/Output: LineI/LineO)

 – [Numeric Calc] > [Absolute Value]
2 7

Round Off
La funzione Round Off (Rnd) consente di arrotondare i valori delle
frazioni decimali dell’argomento in base all’impostazione Number Format
attuale. Ad esempio, il risultato interno e visualizzato di Rnd(10 ÷ 3)
è 3,333, quando l’impostazione Number Format è Fix 3. Utilizzando
l’impostazione Norm 1 o Norm 2 l’argomento viene arrotondato all’11ᵃ cifra
della mantissa.

Esempio: eseguire i calcoli riportati sotto quando per il numero di cifre
visualizzate è selezionata l’impostazione Fix 3: 10 ÷ 3 × 3 e Rnd(10 ÷ 3) ×
3
(Input/Output: MathI/DecimalO, Number Format: Fix 3)

10 3 3

 – [Numeric Calc] > [Round Off]
10 3 3
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Unità angolari, coordinate polari/
cartesiane, sessagesimali
Questa sezione tratta i comandi, le funzioni e i simboli che si possono
inserire dopo aver eseguito l’operazione:  – [Angle/Coord/Sexa].

Degrees, Radians, Gradians
Queste funzioni specificano l’unità angolare.
° specifica il grado, r il radiante e g il gradiente.
Si può inserire ogni funzione utilizzando le seguenti voci del menu.

 – [Angle/Coord/Sexa] > [Degrees]
 – [Angle/Coord/Sexa] > [Radians]
 – [Angle/Coord/Sexa] > [Gradians]

Esempio: π/2 radianti = 90° (Angle Unit: Degree)

(π) 2
 – [Angle/Coord/Sexa] > [Radians]

Rect to Polar, Polar to Rect
“Pol(” consente di convertire le coordinate cartesiane in coordinate polari,
mentre “Rec(” le coordinate polari in coordinate cartesiane.

• Prima di eseguire i calcoli, specificare il valore di Angle Unit nel menu
SETTINGS.

• Il risultato di calcoli di r e θ e di x e y sono memorizzati nelle variabili x e
y, rispettivamente.

• Il risultato del calcolo di θ viene visualizzato nell’intervallo -180° < θ ≤
180°.

Nota

• Pol( e Rec( si possono usare nella schermata dei calcoli dell’app, sotto.•
Calculate, Statistics, Matrix, Vector
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Esempio 1: convertire le coordinate cartesiane (√2, √2) in coordinate
polari (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Rect to Polar]
2 (,) 2

Esempio 2: convertire le coordinate polari (√2, 45°) in coordinate
cartesiane (Input/Output: MathI/MathO, Angle Unit: Degree)

 – [Angle/Coord/Sexa] > [Polar to Rect]
2 (,) 45

Gradi, minuti, secondi
Per inserire il simbolo dei gradi sessagesimali ( ) si possono usare i tasti o
la voce di menu seguenti.

( )
 – [Angle/Coord/Sexa] > [Degs Mins Secs]

Per i dettagli, consultare la sezione “Conversione sessagesimale
(calcoli di gradi, minuti, secondi)” (pagina 48).

Funzioni iperboliche e
trigonometriche
Questa sezione tratta le funzioni iperboliche e trigonometriche.

Funzioni iperboliche
Le funzioni iperboliche si possono inserire utilizzando le seguenti voci del
menu.

 – [Hyperbolic/Trig] > [sinh], [cosh], [tanh], [sinh-1], [cosh-1] o [tanh-1]

Le impostazioni dell’unità di misura degli angoli non influiscono sui calcoli.

Esempio: sinh 1 = 1,175201194

 – [Hyperbolic/Trig] > [sinh] 1
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Funzioni trigonometriche
Le funzioni trigonometriche si possono inserire utilizzando i tasti o le voci
del menu seguenti.

Tasto Voce del menu

 – [Hyperbolic/Trig] > [sin]

 – [Hyperbolic/Trig] > [cos]

 – [Hyperbolic/Trig] > [tan]

(sin-1)  – [Hyperbolic/Trig] > [sin-1]

(cos-1)  – [Hyperbolic/Trig] > [cos-1]

(tan-1)  – [Hyperbolic/Trig] > [tan-1]

Prima di eseguire i calcoli, specificare il valore di Angle Unit nel menu
SETTINGS.

Esempio: sin 30 = 1
2  (Angle Unit: Degree)

30

Simboli scientifici
La calcolatrice supporta 11 simboli scientifici (m, μ, n, p, f, k, M, G, T, P, E)
utilizzabili per inserire valori o visualizzare i risultati dei calcoli.
• I simboli scientifici si possono inserire dopo aver eseguito l’operazione:

 – [Engineer Symbol].
• Per visualizzare i risultati dei calcoli con simboli scientifici, procedere

come segue:  – [Calc Settings] > [Engineer Symbol] > [On].

Esempio di inserimento e calcoli utilizzando i simboli
scientifici

Esempio 1: inserire 500k
(Engineer Symbol: On)
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500  – [Engineer Symbol] > [Kilo] 

Esempio 2: calcolare 999k (migliaia) + 25k (migliaia) = 1,024M (miliardi) =
1024k (migliaia) = 1024000
(Engineer Symbol: On)

999  – [Engineer Symbol] > [Kilo] 
25  – [Engineer Symbol] > [Kilo] 

 – [ENG Notation]
(Passaggio alla modalità di conversione ENG.)

• Premendo ,  o  si esce dalla modalità di conversione ENG e
l’icona  scompare dal display. Per iniziare un nuovo calcolo, uscire
dalla modalità di conversione ENG.

• Per i dettagli sulla modalità di conversione ENG, consultare la sezione
“Notazione scientifica” (pagina 46).

Costanti scientifiche
La calcolatrice è dotata di 47 costanti scientifiche integrate. I valori si
basano sui valori consigliati dal CODATA (2018).

Esempio: inserire la costante scientifica c (velocità della luce nel vuoto) e
visualizzarne il valore
1. Premere , selezionare [Sci Constants], quindi premere .

• Viene visualizzato il menu delle categorie delle costanti scientifiche*.

2. Selezionare [Universal], quindi premere .
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• Viene visualizzato il menu delle costanti scientifiche appartenenti alla
categoria Universal.

3. Selezionare [c] e premere .

4. Premere .

* La tabella seguente contiene le costanti scientifiche di ciascuna
categoria.

Categoria Costanti scientifiche

Universal h, , c, ε0, μ0, Z0, G, lP, tP

Electromagnetic μN, μB, e, Φ0, G0, KJ, RK

Atomic&Nuclear
mp, mn, me, mμ, a0, α, re, λC, γp,
λCp, λCn, R∞, μp, μe, μn, μμ, mτ

Physico-Chem mu, F, NA, k, Vm, R, c1, c2, σ

Adopted Values gn, atm, RK-90, KJ-90

Other t

Conversione di unità
Si possono usare i comandi di conversione delle unità per convertire
un’unità di misura in un’altra. I dati della formula di conversione si basano
sul documento “NIST Special Publication 811 (2008)”.

Esempio: convertire 5 cm in pollici (Input/Output: LineI/LineO)
1. Inserire il valore da convertire.

5
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2. Premere , selezionare [Unit Conversions], quindi premere .
• Viene visualizzato il menu delle categorie delle conversioni*.

3. Selezionare [Length], quindi premere .
• Viene visualizzato il menu dei comandi di conversione appartenenti

alla categoria Length.

4. Selezionare [cm in] (comando di conversione da centimetri a pollici) e
premere .

5. Premere .

* La tabella seguente riporta i comandi di conversione delle unità di
ciascuna categoria.

Categoria Comandi di conversione delle unità

Length
in cm, cm in, ft m, m ft, yd m, m

yd, miglia km, km miglia, n miglia
m, m n miglia, pc km, km pc

Area acri m2, m2 acri

Volume
gal(US) l, l gal(US), gal(UK) l, l
gal(UK)

Mass oz g, g oz, lb kg, kg lb

Velocity km/h m/s, m/s km/h

Pressure
atm Pa, Pa atm, mmHg Pa, Pa

mmHg, kgf/cm2 Pa, Pa kgf/cm2,
lbf/in2 kPa, kPa lbf/in2

Energy kgf m J, J kgf m, J cal15, cal15 J
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*1

*2

*3

Power hp kW, kW hp

Temperature °F °C, °C °F

Altro
Le funzioni e i simboli che si possono inserire con i tasti della calcolatrice,
possono essere inseriti anche dal menu [Other]. Utilizzare  – [Other] per
visualizzare il menu delle funzioni e dei simboli. Ad esempio, per inserire
Ans, è possibile premere  oppure eseguire questa operazione:  –
[Other] > [Ans].
La seguente tabella mostra le voci del menu [Other] corrispondenti a
ciascuna pressione dei tasti.

Voce del menu Tasto

Ans

π (π)

e (e)

√ (

x√ ( ( )

-1 ( )

2

^(

- ((-))

, (,)

(

)

*1 Reciproco
*2 Quadrato
*3 Segno meno

63



Registrazione e utilizzo delle
equazioni caratteristiche per
f(x) e g(x)

Registrazione e utilizzo delle
equazioni caratteristiche per f(x) e
g(x)
La calcolatrice include le funzioni “f(” e “g(” che si possono usare dopo
aver registrato le corrispondenti equazioni caratteristiche. Ad esempio,
dopo aver registrato f(x) = x2 + 1 come equazione caratteristica per la
funzione “f(” sarà possibile calcolare f(0) = 1 e f(5) = 26.
Premendo  viene visualizzato un menu per la registrazione
dell’equazione caratteristica di f(x) o g(x) e per inserire “f(” o “g(”.

Nota

• Le equazioni caratteristiche di f(x) e g(x) vengono utilizzate anche da f(x) e g(x)
nell’app Table. Per informazioni sull’app Table, consultare la sezione “Creazione di
una tabella numerica” (pagina 100).

Registrazione di un’equazione caratteristica
Esempio 1: registrare f(x) = x2 + 1
1. Premere , selezionare l’icona dell’app Calculate, quindi premere .
2. Premere , quindi selezionare [Define f(x)].

• Viene visualizzata la schermata di registrazione dell’equazione f(x).

3. Inserire x2 + 1.

1

4. Premere .
• L’espressione inserita sarà registrata e apparirà nuovamente la

schermata visualizzata prima di premere  nella fase 2 di questa
procedura.
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Nota

• Le equazioni caratteristiche si possono registrare in qualsiasi app della calcolatrice,
tranne Distribution, Equation (Simul Equation / Polynomial), Inequality, Base-N, Ratio
e Math Box. Tuttavia, a seconda della schermata visualizzata dall’app (ad esempio, se
è visibile una schermata di menu), il menu potrebbe non essere accessibile premendo

.

Esecuzione di calcoli mediante l’assegnazione di
un valore all’equazione caratteristica registrata

Esempio 2: assegnare il valore x = 3 a f(x), registrato nell’Esempio 1
(continua dall’Esempio 1)
1. Premere , quindi selezionare [f(x)].

• Verrà inserito “f(”.

2. Assegnare il valore 3, quindi eseguire il calcolo.

3

Registrazione di una funzione composta
Esempio 3: inserire f(x), definito nell’Esempio 1, in g(x) per registrare g(x)
= f(x) × 2 - x
(continua dall’Esempio 1)
1. Premere , quindi selezionare [Define g(x)].

• Viene visualizzata la schermata di registrazione dell’equazione g(x).

2. Inserire f(x) × 2 - x.

* 2

* Premendo  mentre è visibile la schermata di registrazione
dell’equazione g(x), l’unica voce di menu visualizzata è [f(x)].
Analogamente, premendo  mentre è visibile la schermata di
registrazione dell’equazione f(x), l’unica voce di menu visualizzata è
[g(x)].

3. Premere .
• L’equazione inserita viene registrata e si torna alla schermata che era

stata visualizzata prima di iniziare questa operazione con la fase 1.
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Nota

• La procedura per l’assegnazione di un valore a x di g(x) e per il calcolo del risultato è
la stessa descritta nella sezione “Esecuzione di calcoli mediante l’assegnazione di
un valore all’equazione caratteristica registrata” (pagina 65). Occorre però tenere
presente che anziché selezionare [f(x)] nella fase 1, è necessario selezionare [g(x)].

• Nell’Esempio 3 si inserisce f(x) nell’equazione caratteristica di g(x). Viceversa, è
anche possibile inserire g(x) nell’equazione caratteristica f(x). Non è possibile, tuttavia,
inserire g(x) in f(x) e f(x) in g(x) contemporaneamente. Facendolo, si verificherà un
Circular ERROR quando si esegue un calcolo utilizzando f(x) o g(x).

Conservazione dei dati
Eseguendo una delle seguenti si eliminano le equazioni caratteristiche
registrate in f(x) e g(x).

• Pressione di 
• Utilizzo del menu SETTINGS per modificare per alternare

l’impostazione Input/Output tra MathI*1 e LineI*2.
*1 MathI/MathO o MathI/DecimalO
*2 LineI/LineO o LineI/DecimalO

• Esecuzione di  – [Reset] > [Settings & Data] o di  – [Reset] >
[Initialize All]
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Utilizzo delle funzioni QR Code

Utilizzo delle funzioni QR Code
La calcolatrice è in grado di visualizzare i simboli QR Code, che possono
essere letti dai dispositivi smart.

Importante!

• Le operazioni descritte in questa sezione presuppongono che il dispositivo smart in
uso sia dotato di un lettore di QR Code in grado di leggere più simboli QR Code e di
connettersi a Internet.

• Scansionando con un dispositivo smart un QR Code visualizzato dalla calcolatrice, il
dispositivo smart accederà al sito web di CASIO.

Nota

• Sul display viene visualizzata l’indicazione QR Code ogni volta che si preme 
(QR) mentre è visualizzata una delle seguenti schermate.
- Schermata HOME
- Schermata del menu SETTINGS
- Schermate di errore
- Schermate dei risultati dei calcoli in qualsiasi app
- Schermate delle tabelle in qualsiasi app
- Schermata dell’app Spreadsheet
Per i dettagli, visitare il sito web di CASIO (https://wes.casio.com).

Visualizzazione di un QR Code
Esempio: visualizzare il QR Code del risultato di un calcolo nell’app
Calculate e scansionarlo con un dispositivo smart
1. Eseguire alcuni calcoli nell’app Calculate.
2. Premere (QR) per visualizzare il QR Code.

• I numeri nell’angolo inferiore destro del display mostrano il numero
del QR Code attuale e il numero totale di simboli QR Code. Per
visualizzare il QR Code successivo, premere  o .

Nota

• Per tornare a un QR Code precedente, premere ripetutamente  o  per
scorrere in avanti fino a visualizzarlo.

3. Con un dispositivo smart, scansionare il QR Code sul display della
calcolatrice.
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• Per informazioni su come scansionare un QR Code, consultare la
documentazione del lettore di QR Code in uso.

In caso di difficoltà nella scansione di un QR Code
Mentre il QR Code è visibile, premere  e  per regolare il contrasto del
display nella schermata del QR Code. Questa regolazione del contrasto
ha effetto solo nelle schermate dei QR Code.

Importante!

• A seconda del dispositivo smart e/o dell’app per la lettura dei QR Code, potrebbero
verificarsi dei problemi durante la scansione dei simboli QR Code generati da questa
calcolatrice.

• Se l’impostazione “QR Code” del menu SETTINGS è regolata su “Version 3”, le app
in grado di visualizzare i simboli QR Code sono limitate. Se si cerca di visualizzare
un QR Code in un’app che non supporta la visualizzazione dei QR Code, verrà
visualizzato il messaggio “Not Supported (Version 3)”. Il QR Code generato con
questa impostazione, tuttavia, si scansiona più facilmente, con un dispositivo smart.

• Per ulteriori informazioni, visitare il sito web di CASIO (https://wes.casio.com).
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Utilizzo delle app della
calcolatrice

Calcoli statistici
L’app Statistics calcola diversi valori statistici in base a dati con variabile
singola (x) o variabili abbinate (x, y).

Procedura generale per eseguire un calcolo
statistico

1. Premere , selezionare l’icona dell’app Statistics, quindi premere .
2. Nel menu visualizzato selezionare [1-Variable] (variabile singola) o [2-

Variable] (variabili abbinate), quindi premere .
• Viene visualizzato l’editor dei calcoli statistici.

Variabile singola

Variabili abbinate

3. Visualizzare la colonna Freq (frequenza), se necessario.
• Per i dettagli, consultare la sezione “Colonna Freq (Frequenza)”

(pagina 71).
4. Inserire i dati.

• Per i dettagli, consultare la sezione “Inserimento di dati con l’editor
dei calcoli statistici” (pagina 70).

5. Dopo aver inserito i dati, premere .
• Verrò visualizzato il seguente menu.
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Variabile singola

Variabili abbinate

6. Selezionare la voce di menu corrispondente all’operazione da eseguire.
• Selezionare [1-Var Results], [2-Var Results] o [Reg Results] per

visualizzare un elenco dei risultati del calcolo per i dati inseriti. Per
informazioni dettagliate, consultare la sezione “Visualizzazione dei
risultati dei calcoli statistici” (pagina 73).

• Per visualizzare un schermata dei calcoli statistici ed eseguire i
calcoli per i dati inseriti, selezionare [Statistics Calc]. Per informazioni
dettagliate, consultare la sezione “Utilizzo della schermata dei
calcoli statistici” (pagina 77).

Nota

• Per tornare all’editor dei calcoli statistici da una schermata dei calcoli statistici,
premere  seguito da .

Inserimento di dati con l’editor dei calcoli statistici
L’editor dei calcoli statistici può visualizzare una, due o tre colonne:
variabile singola (x), variabile singola e frequenza (x, Freq), variabili
abbinate (x, y), variabili abbinate e frequenza (x, y, Freq). Il numero di
righe di dati che si possono inserire dipende dal numero di colonne: 160
righe per una colonna, 80 righe per due colonne, 53 righe per tre colonne.

Importante!

• Tutti i dati inserito nell’editor dei calcoli statistici vengono eliminati ogni volta che si
esegue una delle seguenti operazioni.
- Passaggio dal calcolo statistico tra quello con variabile singola e quello con variabili

abbinate
- Modifica dell’impostazione Frequency nel menu TOOLS

• Se si inseriscono molti dati, i calcoli statistici possono richiedere parecchio tempo.
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Colonna Freq (Frequenza)

Se si attiva l’impostazione Frequency nel menu TOOLS, nell’editor delle
statistiche sarà presenta anche la colonna “Freq”. La colonna Freq
consente di specificare la frequenza (il numero di volte in cui lo stesso
campione viene visualizzato nel gruppo di dati) di ciascun valore del
campione.

Variabile singola

Variabili abbinate

Visualizzazione della colonna Freq
1. Quando è visualizzato l’editor dei calcoli statistici, premere , quindi

selezionare [Frequency] > [On].
2. Premere  per tornare all’editor dei calcoli statistici.

Rimozione della colonna Freq
1. Quando è visualizzato l’editor dei calcoli statistici, premere , quindi

selezionare [Frequency] > [Off].
2. Premere  per tornare all’editor dei calcoli statistici.

Regole per l’inserimento dei dati dei campioni nell’editor dei
calcoli statistici

I dati vengono inseriti nella cella in cui si trova il cursore. Con i tasti
cursore si può spostare il cursore tra le celle.

   Cursore
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Dopo aver inserito un valore, premere . Il valore viene registrato e nella
cella vengono visualizzate fino a sei delle sue cifre.

Esempio 1: selezionare delle variabili abbinate e inserire i seguenti dati:
(170, 66), (179, 75), (173, 68)
1. Premere , selezionare l’icona dell’app Statistics, quindi premere .
2. Selezionare [2-Variable], quindi premere .

3. Con l’operazione seguente, inserire i dati.

170 179 173
66 75 68

Nota

• Nell’editor dei calcoli statistici è possibile memorizzare in una variabile il valore in una
cella. Ad esempio, eseguendo la seguente operazione mentre è visibile la schermata
di cui alla fase 3, il valore 68 verrà memorizzato nella variabile A:  – [A=] >
[Store]. Per informazioni dettagliate sulle variabili, consultare la sezione “Variabili (A,
B, C, D, E, F, x, y, z)” (pagina 39).

Modifica dei dati del campione

Sostituzione dei dati in una cella
Nell’editor dei calcoli statistici, spostare il cursore nella cella contenente i
dati da modificare, inserire i nuovi dati, quindi premere .

Eliminazione di una riga
Nell’editor dei calcoli statistici, spostare il cursore nella riga da eliminare,
quindi premere .

Inserimento di una riga
1. Nell’editor dei calcoli statistici, spostare il cursore nella riga che si

troverà sotto la riga da inserire.
2. Eseguire la seguente operazione:  – [Edit] > [Insert Row].

Eliminazione di tutto il contenuto dell’editor dei calcoli statistici
Nell’editor dei calcoli statistici, procedere come segue:  – [Edit] >
[Delete All].
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Ordinamento dei dati

Nell’editor dei calcoli statistici si possono disporre i dati in ordine crescente
o decrescente in base ai valori delle colonne x, y o Freq.

Importante!

• Nota: dopo aver modificato l’ordinamento dei dati non sarà possibile ripristinare
l’ordinamento originale.

Esempio 2: disporre i dati dell’Esempio 1 (pagina 71) in ordine crescente
nella colonna x, quindi in ordine decrescente nella colonna y
1. Inserire i dati con la procedura dell’Esempio 1.

2. Disporre i dati in ordine crescente nella colonna x.

 – [Sort] > [x Ascending]

3. Disporre i dati in ordine decrescente nella colonna y.

 – [Sort] > [y Descending]

Visualizzazione dei risultati dei calcoli statistici

Visualizzazione dei risultati dei calcoli statistici con variabile
singola

La schermata 1-Var Results mostra un elenco di diversi valori statistici, ad
esempio la media e la deviazione standard della popolazione, calcolati
in base a dati con variabile singola. Questa sezione spiega come
visualizzare la schermata 1-Var Results.

Esempio 3: inserire i seguenti dati e visualizzare i risultati di un calcolo
statistico con variabile singola

x 1 2 3 4 5 6 7 8 9 10
Freq 1 2 1 2 2 2 3 4 2 1

1. Premere , selezionare l’icona dell’app Statistics, quindi premere .
2. Selezionare [1-Variable], quindi premere .
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• Viene visualizzato l’editor dei calcoli statistici.
3. Premere , quindi selezionare [Frequency] > [On].

• Premere  per tornare all’editor dei calcoli statistici.
4. Inserire i dati nella colonna x.

1 2 3 4 5 6 7 8 9 10

5. Inserire i dati nella colonna Freq.

2 2 2 2 3 4 2

6. Premere .

7. Selezionare [1-Var Results], quindi premere .
• Viene visualizzata la schermata 1-Var Results.

 (oppure )

 (oppure )

• Per il significato delle variabili visibili nella schermata 1-Var Results,
consultare la sezione “Elenco delle variabili dei valori statistici e
funzioni di calcolo statistico” (pagina 80).

8. Premere  o  per tornare all’editor dei calcoli statistici.

Visualizzazione dei risultati dei calcoli statistici con variabili
abbinate

La schermata 2-Var Results mostra un elenco di diversi valori statistici, ad
esempio la media e la deviazione standard della popolazione, calcolati
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in base a dati con variabili abbinate. Questa sezione spiega come
visualizzare la schermata 2-Var Results.

Esempio 4: inserire i seguenti dati e visualizzare i risultati di un calcolo
statistico con variabili abbinate

x 1,0 1,2 1,5 1,6 1,9 2,1 2,4 2,5 2,7 3,0
y 1,0 1,1 1,2 1,3 1,4 1,5 1,6 1,7 1,8 2,0

1. Premere , selezionare l’icona dell’app Statistics, quindi premere .
2. Selezionare [2-Variable], quindi premere .

• Viene visualizzato l’editor dei calcoli statistici.
3. Inserire i dati nella colonna x.

1 1 2 1 5 1 6 1 9
2 1 2 4 2 5 2 7 3

4. Inserire i dati nella colonna y.

1 1 1 1 2 1 3 1 4
1 5 1 6 1 7 1 8 2

5. Premere .

6. Selezionare [2-Var Results], quindi premere .
• Viene visualizzata la schermata 2-Var Results.

 (oppure )

 (oppure )

 (oppure )
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• Per il significato delle variabili visibili nella schermata 2-Var Results,
consultare la sezione “Elenco delle variabili dei valori statistici e
funzioni di calcolo statistico” (pagina 80).

7. Premere  o  per tornare all’editor dei calcoli statistici.

Visualizzazione dei risultati di un calcolo di regressione

La schermata Reg Results visualizza un elenco dei risultati di un calcolo di
regressione (coefficienti delle equazioni di regressione) in base a dati con
variabili abbinate. Questa sezione spiega come visualizzare la schermata
Reg Results.

Esempio 5: utilizzare i dati con variabili abbinate inseriti nell’Esempio 4
(pagina 74) e visualizzare i risultati dei due calcoli di regressione mostrati
di seguito
• I coefficienti (a, b) dell’equazione di regressione “y = a + bx” e il

coefficiente di correlazione (r) quando si esegue una regressione lineare
sui dati

• I coefficienti (a, b, c) dell’equazione di regressione “y = a + bx + cx2”
quando si esegue una regressione polinomiale sui dati

Nota

• Per informazioni sui tipi di calcolo della regressione supportati dall’app Statistics,
consultare la sezione “Elenco dei tipi di regressione supportati” (pagina 77).

1. Eseguire i passaggi da 1 a 5 della procedura descritta nell’Esempio 4
(pagina 74).

2. Selezionare [Reg Results], quindi premere .
• Viene visualizzato il menu dei tipi di regressione.

3. Selezionare [y=a+bx], quindi premere .
• Viene visualizzata la schermata Reg Results della regressione

lineare.

4. Premere  o  per tornare all’editor dei calcoli statistici.
5. Premere , quindi selezionare [Reg Results] > [y=a+bx+cx2].
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• Viene visualizzata la schermata Reg Results della regressione
polinomiale.

6. Premere  o  per tornare all’editor dei calcoli statistici.
• Per il significato delle variabili di cui alla schermata Reg Results,

consultare la sezione “Elenco delle variabili dei valori statistici e
funzioni di calcolo statistico” (pagina 80).

Elenco dei tipi di regressione supportati

Tipo di regressione
Equazione di regressione

(voce di menu tipo regressione)

Regressione lineare y = a + bx

Regressione polinomiale y = a + bx + cx2

Regressione logaritmica y = a + b･ln(x)

Regressione esponenziale e y = a･e^(bx)

Regressione esponenziale ab y = a･b^x

Regressione di potenza y = a･x^b

Regressione inversa y = a + b/x

Utilizzo della schermata dei calcoli statistici
La schermata dei calcoli statistici consente di richiamare i singoli valori
statistici e di utilizzarli nei calcoli.

Schermata senza espressione inserita
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Calcolo esemplificativo

Per richiamare un valore statistico si utilizza una variabile che rappresenta
tale valore (ad esempio, media di x: x, deviazione standard della
popolazione x: σx, valore massimo di x: max(x) e così via). Per ulteriori
informazioni su queste variabili, consultare la sezione “Elenco delle
variabili dei valori statistici e funzioni di calcolo statistico” (pagina
80).

Visualizzazione di una schermata dei calcoli statistici

Variabile singola
1. Mentre l’editor dei calcoli statistici è visibile, premere .
2. Nel menu visualizzato selezionare [Statistics Calc] e premere .

Variabili abbinate
1. Mentre l’editor dei calcoli statistici è visibile, premere .
2. Nel menu visualizzato selezionare [Statistics Calc] e premere .

• Viene visualizzato il menu dei tipi di regressione (consultare la
sezione “Elenco dei tipi di regressione supportati” (pagina 77)).

3. Nel menu, selezionare il tipo di regressione e premere .

• Nell’esempio precedente, selezionare nel menu visualizzato [y=a+bx]
(regressione lineare).
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Ritorno all’editor dei calcoli statistici da una schermata dei calcoli
statistici
Premere , quindi .

Esempio di calcolo nella schermata dei calcoli statistici

Esempio 6: determinare la somma dei dati del campione (Σx) e la media
(x) dei dati con variabile singola inseriti nell’Esempio 3 (pagina 73)
1. Eseguire i passaggi da 1 a 6 della procedura descritta nell’Esempio 3

(pagina 73).
2. Selezionare [Statistics Calc] e premere .

3. Calcolare la somma dei dati del campione (Σx).

 – [Statistics] > [Summation] > [Σx]

4. Calcolare la media (x).

 – [Statistics] >
[Mean/Var/Dev...] > [x]

Nota

• Per visualizzare la schermata 1-Var Results partendo dalla schermata dei calcoli
statistici visualizzata sopra, premere , quindi selezionare [1-Var Results]. Per
tornare alla schermata dei calcoli statistici dalla schermata 1-Var Results, premere

 o .

Esempio 7: determinare i coefficienti (a, b) e il coefficiente di correlazione
(r) dell’equazione di regressione lineare “y = a + bx” per i dati con variabili
abbinate inseriti nell’Esempio 4 (pagina 74)
1. Eseguire i passaggi da 1 a 5 della procedura descritta nell’Esempio 4

(pagina 74).
2. Selezionare [Statistics Calc] e premere .

• Viene visualizzato il menu dei tipi di regressione.
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3. Selezionare [y=a+bx], quindi premere .

4. Determinare i coefficienti (a, b) e il coefficiente di correlazione (r)
dell’equazione di regressione “y = a + bx”.

 – [Statistics] > [Regression] > [a]

 – [Statistics] > [Regression] > [b]

 – [Statistics] > [Regression] > [r]

• Per selezionare un altro tipo di regressione, premere  quindi
selezionare [Select Reg Type]. Viene visualizzato il menu dei tipi di
regressione della fase 2.

Visualizzazione della schermata 2-Var Results da una schermata dei
calcoli statistici
Premere , quindi selezionare [2-Var Results].

Visualizzazione della schermata Reg Results da una schermata dei
calcoli statistici
Premere , quindi selezionare [Reg Results].

Elenco delle variabili dei valori statistici e funzioni di calcolo
statistico

Il menu CATALOG consente di richiamare le variabili che rappresentano i
valori statistici e le funzioni utilizzate per i calcoli statistici.

Nota

• Per i calcoli statistici con variabile singola sono disponibili le variabili contrassegnate
da un asterisco (*).
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• Per la formula di calcolo utilizzata per ogni variabile e ogni comando, consultare la
sezione “Formula per calcoli statistici” (pagina 84).

 – [Statistics] > [Summation]
Σx*, Σy ...... somma dei dati del campione
Σx2*, Σy2 ...... somma dei quadrati dei dati del campione
Σxy ...... somma dei prodotti dei dati x e dei dati y
Σx3 ...... somma dei cubi dei dati x
Σx2y ...... somma dei (quadrati dei dati x × dati y)
Σx4 ...... somma dei quadrati dei quadrati dei dati x

 – [Statistics] > [Mean/Var/Dev...]
x*, y ...... media
σ2

x*, σ2
y ...... varianza della popolazione

σx*, σy ...... deviazione standard della popolazione
s2

x*, s2
y ...... varianza del campione

sx*, sy ...... deviazione standard del campione
n* ...... numero di elementi

 – [Statistics] > [Min/Max/Quartile] (solo dati con variabile singola)
min(x)* ...... valore minimo
Q1* ...... primo quartile
Med* ...... mediana
Q3* ...... terzo quartile
max(x)* ...... valore massimo

 – [Statistics] > [Norm Dist] (solo dati con variabile singola)
P(*, Q(*, R(*, t* ...... Funzioni per eseguire calcoli con la distribuzione
normale. Per ulteriori informazioni su queste funzioni, consultare la
sezione “Esecuzione di calcoli con la distribuzione normale (solo
dati con variabile singola)” (pagina 82).

 – [Statistics] > [Min/Max] (solo dati con variabili abbinate)
min(x), min(y) ...... valore minimo
max(x), max(y) ...... valore massimo

 – [Statistics] > [Regression] (solo dati con variabili abbinate)

Per la regressione polinomiale
a, b, c...... coefficienti di regressione per la regressione polinomiale
x̂1, x̂2 ...... Funzioni per determinare i valori stimati di x1 e x2

per un valore di y inserito. Per l’argomento, inserire il valore di y
immediatamente prima della funzione x̂1 o x̂2.
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ŷ ...... Funzione per determinare il valore stimato y per un valore di x
inserito. Per l’argomento, inserire il valore di x immediatamente prima di
questa funzione.

Per la regressione non polinomiale
a, b ...... coefficienti di regressione
r ...... coefficiente di correlazione
x̂ ...... Funzione per determinare il valore stimato di x per un valore di y
inserito. Per l’argomento, inserire il valore di y immediatamente prima di
questa funzione.
ŷ ...... Funzione per determinare il valore stimato y per un valore di x
inserito. Per l’argomento, inserire il valore di x immediatamente prima di
questa funzione.
Per un esempio di determinazione di valori stimati, consultare la sezione
“Calcolo di valori stimati (solo dati con variabili abbinate)” (pagina
83).

Esecuzione di calcoli con la distribuzione normale (solo dati
con variabile singola)

Quando è selezionata l’opzione di calcolo statistico con variabile singola è
possibile eseguire calcoli con la distribuzione normale usando le funzioni
mostrate di seguito, nel menu visualizzato quando si preme  e si
seleziona [Statistics] > [Norm Dist].

P(, Q(, R( ... Queste funzioni prendono l’argomento t e determinano
la probabilità di una distribuzione normale standard, come illustrato di
seguito.

t ...... Questa funzione è preceduta dall’argomento x. Consente di
calcolare la variazione standard per il valore x utilizzando il valore medio
(x) e la deviazione standard della popolazione (σx) per i dati inseriti con
l’editor dei calcoli statistici.

Esempio 8: per dati con variabile singola inseriti nell’Esempio 3 (pagina
73), determinare la variazione normalizzata quando x = 2 e P(t) in quel
punto.
1. Eseguire i passaggi da 1 a 6 della procedura descritta nell’Esempio 3

(pagina 73).
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2. Selezionare [Statistics Calc] e premere .

3. Calcolare la variazione normalizzata quando x = 2.

2
 – [Statistics] > [Norm Dist] > [ t]

4. Calcolare P(t).

 – [Statistics] > [Norm Dist] > [P(]

Calcolo di valori stimati (solo dati con variabili abbinate)

Sulla base dell’equazione di regressione ottenuta mediante il calcolo
statistico con variabili abbinate, si può calcolare il valore stimato di y per
un dato valore di x. Il valore di x corrispondente (due valori, x1 e x2, nel
caso della regressione polinomiale) si può calcolare anche per un valore
di y nell’equazione di regressione.

Esempio 9: determinare il valore stimato di y quando x = 5,5
nell’equazione di regressione prodotta dalla regressione lineare dei dati
inseriti nell’Esempio 4 (pagina 74)
1. Eseguire i passaggi da 1 a 5 della procedura descritta nell’Esempio 4

(pagina 74).
2. Selezionare [Statistics Calc] e premere .

• Viene visualizzato il menu dei tipi di regressione.

3. Selezionare [y=a+bx], quindi premere .

4. Inserire il valore di x (5,5), quindi inserire “ŷ”, che è la funzione utilizzata
per determinare il valore stimato di y.

83



5 5
 – [Statistics] > [Regression] > [ŷ]

5. Premere .

Formula per calcoli statistici

Formula per calcoli statistici con variabile singola

Formula per calcoli statistici con variabili abbinate

Formula per il calcolo della regressione

Regressione lineare (y = a + bx)
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Regressione polinomiale (y = a + bx + cx2)

Regressione logaritmica (y = a + b･ln(x))

Regressione esponenziale e (y = a･e^(bx))
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Regressione esponenziale ab (y = a･b^x)

Regressione di potenza (y = a･x^b)

Regressione inversa (y = a + b/x)
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Calcoli di distribuzione
L’app Distribution consente di ottenere il valore di probabilità selezionando
il tipo di calcolo della distribuzione e inserendo vari parametri.* La tabella
seguente riporta i tipi di calcolo di distribuzione eseguibili.

Tipo di calcolo di distribuzione Voce del menu

Probabilità binomiale Binomial PD

Probabilità binomiale cumulativa Binomial CD

Densità di probabilità normale Normal PD

Probabilità normale cumulativa Normal CD

Distribuzione normale inversa cumulativa* Inverse Normal

Probabilità di Poisson Poisson PD

Probabilità di Poisson cumulativa Poisson CD

* La funzione “Inverse Normal” esegue il calcolo inverso per determinare il
valore dei dati (xInv) da un valore di probabilità (Area).

Procedura generale per eseguire un calcolo di
distribuzione

Esempio: calcolare la probabilità binomiale cumulativa per i dati x {2, 3, 4,
5} quando N (numero di prove) = 5 e p (probabilità di successo) = 0,5

1. Premere , selezionare l’icona dell’app Distribution, quindi premere
.

• Viene visualizzato il menu del tipo di calcolo della distribuzione.

2. Nel menu, selezionare un tipo di calcolo della distribuzione.
• Qui si vole calcolare la probabilità binomiale cumulativa. Selezionare

[Binomial CD] e premere .
3. Nel menu visualizzato, selezionare un metodo di inserimento dei dati

(x).
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[List] ... Selezionare questa opzione per inserire più elementi di dati x
contemporaneamente. Selezionando questa voce viene visualizzata
la schermata dell’elenco.

[Variable] ... Selezionare per inserire un singolo elemento di dati
x. Selezionando questa voce viene visualizzata la schermata di
inserimento dei parametri.

• Qui si vogliono inserire più elementi di dati x contemporaneamente,
quindi selezioneremo [List], per poi premere .

4. Nella schermata dell’elenco, inserire i dati x {2, 3, 4, 5}.

2 3 4 5

5. Premere .
• Viene visualizzata la schermata di inserimento dei parametri Binomial

CD.
6. Inserire i valori dei parametri (N = 5, p = 0,5).

5 0 5

• I parametri che richiedono l’inserimento dei dati dipendono dal tipo di
calcolo selezionato nella fase 2 di questa procedura. Per i dettagli,
consultare la sezione “Elenco dei parametri” (pagina 89).

7. Dopo aver inserito i valori di tutte le variabili, selezionare [Execute] e
premere .
• Viene visualizzata la schermata dei risultati del calcolo.

• Se nella fase 3 è stata selezionata l’opzione [List], i risultati del
calcolo (colonna P) verranno visualizzati nella schermata dell’elenco.
Per informazioni dettagliate, consultare la sezione “Schermata
dell’elenco” (pagina 90).

• Se si esegue qualsiasi modifica (consultare la sezione “Modifica
del contenuto della schermata dell’elenco” (pagina 91)) nella
schermata dell’elenco mentre sono visualizzati i risultati del calcolo,
tutti i risultati verranno cancellati. L’elenco tornerà allo stato in cui si
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trovava nella fase 4 (inserimento completo dei dati nella schermata
dell’elenco) di questa procedura.

• Se il valore inserito non rientra nell’intervallo consentito, verrà
visualizzato un messaggio di errore. Nella colonna P della schermata
dei risultati del calcolo verrà visualizzato il testo “ERRORE”, se il
valore inserito per i dati non rientra nell’intervallo consentito.

• Premendo  mentre è visualizzata la schermata dei risultati del
calcolo si tornerà alla schermata di inserimento dei parametri.

Nota

• Se nella fase 2, sopra, è stata selezionata l’opzione Normal PD, Normal CD o Inverse
Normal, il metodo di inserimento dei dati (x) sarà sempre “Variable” (inserimento di dati
x singoli). Di conseguenza in quel caso non verrà non visualizzato il menu della fase 3.

• Se il metodo di inserimento dei dati (x) è “Variable”, il risultato del calcolo verrà
memorizzato nella memoria Ans.

• La precisione del calcolo della distribuzione arriva a 6 cifre significative.

Elenco dei parametri
L’elenco seguente riporta il significato dei simboli visibili nella schermata di
inserimento dei parametri.

Binomial PD, Binomial CD
x … dati
N … numero di prove
p … probabilità di successo (0 ≤ p ≤ 1)

Normal PD
x … dati
μ … media della popolazione
σ … deviazione standard della popolazione (σ > 0)

Normal CD
Lower … limite inferiore
Upper … limite superiore
μ … media della popolazione
σ … deviazione standard della popolazione (σ > 0)

Inverse Normal
Area … valore di probabilità (0 ≤ Area ≤ 1)
μ … media della popolazione
σ … deviazione standard della popolazione (σ > 0)
(coda sempre a sinistra)
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Poisson PD, Poisson CD
x … dati
λ … media

Nota

• L’ultimo valore inserito per ogni di parametro viene conservato indipendentemente
dalla schermata nella quale è stato inserito. Ad esempio, inserendo un valore per N
nella scherma di inserimento del parametro Binomial PD modificherà anche il valore di
N nella scherma di inserimento del parametro Binomial CD.

• I valori di ciascun parametro vengono conservati fino a quando si esegue una delle
seguenti operazioni:  – [Reset] > [Settings & Data] o  – [Reset] > [Initialize All].

Schermata dell’elenco
La schermata dell’elenco consente di inserire fino a 45 dati x. I risultati del
calcolo vengono visualizzati anche nella schermata dell’elenco.

(1) Tipo di calcolo di distribuzione
(2) Valore per la posizione attuale del cursore
(3) Dati (x)
(4) Risultati del calcolo (P)

Nota

• Nella schermata dell’elenco è possibile memorizzare in una variabile il valore in una
cella. Ad esempio, eseguendo la seguente operazione mentre e visibile la schermata
di cui sopra, si memorizzerà il valore 1 nella variabile A:  – [A=] > [Store]. Per
informazioni dettagliate sulle variabili, consultare la sezione “Variabili (A, B, C, D, E,
F, x, y, z)” (pagina 39).

• Eseguendo una delle seguenti operazioni si eliminano tutti i dati x inseriti nella
schermata dell’elenco.
- Ritorno alla schermata HOME e avvio di un’altra app della calcolatrice
- Esecuzione dell’opzione [Delete All] (consultare la sezione “Eliminazione di tutto il

contenuto della schermata dell’elenco” (pagina 91).)
- Esecuzione di  – [Reset] > [Settings & Data] o di  – [Reset] > [Initialize All]
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Modifica del contenuto della schermata dell’elenco

Modificare dei dati x in una cella

Nella schermata dell’elenco, spostare il cursore nella cella contenente i
dati da modificare, inserire i nuovi dati, quindi premere .

Eliminazione di una riga

Nella schermata dell’elenco, spostare il cursore nella riga da eliminare,
quindi premere .

Inserimento di una riga

1. Nella schermata dell’elenco, spostare il cursore nella riga che si troverà
sotto la riga da inserire.

2. Eseguire la seguente operazione:  – [Edit] > [Insert Row].
• Verrà inserita una riga con 0 come valore predefinito iniziale.

3. Inserire i dati.

Eliminazione di tutto il contenuto della schermata dell’elenco

Nella schermata dell’elenco, procedere come segue:  – [Edit] > [Delete
All].

Esempio di calcolo
Calcolare la densità di probabilità normale quando x = 36, μ = 35, σ = 2
1. Premere , selezionare l’icona dell’app Distribution, quindi premere

.
2. Nel menu del tipo di calcolo della distribuzione visualizzato, selezionare

[Normal PD] e premere .
• Viene visualizzata la schermata di inserimento dei parametri Normal

PD.
3. Inserire i valori dei parametri (x = 36, μ = 35, σ = 2).

36 35 2

4. Premere .
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• Premendo nuovamente  o premendo  o  torna alla schermata
di inserimento dei parametri vista nella fase 3 di questa procedura.

• È possibile memorizzare in una variabile il risultato del calcolo
visualizzato. Ad esempio, eseguendo la seguente operazione mentre
è visibile la schermata di cui alla fase 4, il risultato del calcolo verrà
memorizzato nella variabile A:  – [A=] > [Store]. Per informazioni
dettagliate sulle variabili, consultare la sezione “Variabili (A, B, C, D,
E, F, x, y, z)” (pagina 39).

Utilizzo di un foglio di calcolo
L’app Spreadsheet consente di eseguire calcoli in un foglio di calcolo a 45
righe × 5 colonne (celle da A1 a E45).
Per eseguire le operazioni di questa sezione, avviare l’app Spreadsheet.
Premere , selezionare l’icona dell’app Spreadsheet, quindi premere .
Viene visualizzata la schermata del foglio di calcolo.

(1) Numeri delle righe (da 1 a 45)
(2) Lettere delle colonne (da A a E)
(3) Cursore: indica la cella attualmente selezionata. Il numero della riga

e la lettera della colonna che si riferiscono alla cella selezionata sono
visualizzati in nero; i numeri delle altre riga e le lettere delle altre
colonne in grigio scuro.

(4) Riquadro di modifica: mostra il contenuto della cella in cui è presente
il cursore.

Importante!

• Ogni volta che si spegne la calcolatrice o si preme il tasto , tutti i valori nel foglio di
calcolo vengono cancellati.

Inserimento e modifica del contenuto delle celle
È possibile inserire in ciascuna cella una costante o una formula.
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Costanti: una costante assume un valore fisso appena se ne
completa l’inserimento. Una costante può essere un valore numerico
o un’espressione (ad esempio 7+3, sin30, A1×2 ecc.) senza segno di
uguale (=) davanti.
Formule: una formula che inizia con un segno di uguale (=), ad esempio
=A1×2, viene eseguita così come è scritta.

Nota

• È possibile inserire fino a 49 byte nella cella (numero di byte prima di confermare
l’inserimento premendo ) che si modifica. Ecco di seguito il metodo di conteggio
del numero di byte.
- Numeri, variabili, simboli: 1 byte per ogni carattere
- Comandi, funzioni: 1 byte ciascuno

Ogni comando o funzione equivale a un byte. Ad esempio, quanto segue equivale a
un byte: “√ (”, “Sum(”.

• I byte considerati dopo la conferma dell’inserimento sono quelli mostrati di seguito, in
base al contenuto inserito in ciascuna cella.
- Costanti: 14 byte indipendentemente dal numero di cifre inserite*
- Formule: numero di byte inseriti (al massimo 49 byte) + 15 byte
* Se si inserisce una costante composta da 11 o più cifre significative, il valore verrà

convertito in 10 cifre significative alla conferma dell’inserimento.
Esempio: se si inserisce 12345678915 (11 cifre), il valore verrà convertito in
1,234567892 x 1010 (10 cifre).

Per visualizzare la capacità di inserimento rimanente

Premere , selezionare [Available Memory], quindi premere .

Inserimento di una costante e di una formula in
una cella

Esempio 1: nelle celle A1, A2 e A3, inserire rispettivamente le costanti
7×5, 7×6 e A2+7. Inserire quindi nella cella B1 la seguente formula:
=A1+7.
1. Spostare il cursore nella cella A1.
2. Premere la sequenza di tasti riportata qui sotto.

7 5 7 6 (A) 7

3. Spostare il cursore nella cella B1, quindi premere la sequenza di tasti
riportata di seguito.
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(=) (A) 7

Nota

• Nella schermata del foglio di calcolo è possibile memorizzare in una variabile il valore
in una cella. Ad esempio, eseguendo la seguente operazione mentre è visibile la
schermata di cui alla fase 3 si memorizzerà nella variabile A il valore 42 (risultato del
calcolo della formula inserita nella cella B1):  – [A=] > [Store]. Per informazioni
dettagliate sulle variabili, consultare la sezione “Variabili (A, B, C, D, E, F, x, y, z)”
(pagina 39).

• È possibile stabilire se una formula presente nel riquadro di modifica deve essere
visualizzata così com’è oppure se visualizzare il risultato del calcolo. Consultare la
sezione “Parametri delle impostazioni dell’app Spreadsheet” (pagina 99).

Per modificare i dati esistenti nelle celle

1. Spostare il cursore nella cella di cui si vuole modificare il contenuto e
premere .
• Anziché premere  è anche possibile eseguire l’operazione che

segue.
 – [Edit Cell]

• L’allineamento del contenuto delle celle nel riquadro di modifica
passerà destra a sinistra. Nel riquadro di modifica verrà visualizzato
un cursore di testo (|) che permette di modificare il contenuto.

2. Con  e , spostare il cursore sul contenuto della cella e modificarlo
in base alle esigenze.

3. Per completare e confermare le modifiche, premere .

Per inserire un nome di riferimento in un cella utilizzando il
comando Grab

Il comando Grab è utilizzabile al posto dell’inserimento manuale per
assegnare un nome di riferimento (ad esempio A1), premendo i tasti per
selezionare e inserire la cella di riferimento.

Esempio 2: continuando dall’Esempio 1, inserire nella cella B2 la
seguente formula: =A2+7.
1. Spostare il cursore nella cella B2.
2. Eseguire l’operazione che segue.

(=) – [Spreadsheet] > [Grab]
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7

Riferimenti relativi e assoluti delle celle
Esistono due tipi di riferimento per le celle: relativo e assoluto.

Riferimento relativo di una cella

Il riferimento della cella (A1) in una formula come =A1+7 è relativo, ovvero
cambia in base alla cella in cui è presente la formula. Se la formula =A1+7
in origine si trova ad esempio nella cella B1, copiandola e incollandola,
ad esempio, nella cella C3, si otterrà =B3+7 come valore della cella C3.
Poiché l’operazione copia-incolla sposta la formula di una colonna (da
B a C) e di due righe (da 1 a 3), il riferimento relativo della cella A1
contenuto nella formula si sposta di una colonna e di due righe, in B3. Se
a seguito di un’operazione di copia-incolla il nome di un riferimento relativo
di una cella cambia in un nome non compreso nell’intervallo delle celle del
foglio di calcolo, la lettera della colonna e/o il numero della riga pertinenti
verranno sostituiti da un punto interrogativo (?) e al posto dei dati, nella
cella, verrà visualizzata la stringa “ERROR” .

Riferimento assoluto di una cella

Se si desidera che nel nome del riferimento di una cella la riga o
la colonna, o entrambe, rimangano invariate indipendentemente dalla
posizione in cui vengono incollate, è necessario creare un nome di
riferimento assoluto per la cella. Per creare un riferimento assoluto,
anteporre il simbolo del dollaro ( ) al nome della colonna e/o al numero
della riga. Si possono utilizzare tre riferimenti assoluti diversi: colonna
assoluta con riga relativa ( A1), colonna relativa con riga assoluta (A 1)
o riga e colonna assolute ( A 1).

Come inserire il simbolo del riferimento assoluto della cella
( )

Quando si inserisce una formula in una cella, premere , quindi
selezionare [Spreadsheet] > [ ].

Per tagliare e incollare i dati nel foglio di calcolo

1. Spostare il cursore sulla cella da cui tagliare i dati.
2. Premere , selezionare [Cut & Paste], quindi premere .
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• Si passa allo stato di standby dell’operazione “incolla”. Per annullare
lo standby, premere  o .

3. Spostare il cursore nella cella in cui incollare i dati appena tagliati,
quindi premere .
• Incollando i dati, questi vengono eliminati dalla cella in cui è stata

eseguita l’operazione di taglio e si annulla automaticamente lo
standby.

Nota

• Nel caso di un’operazione taglia-incolla, i riferimenti della cella non cambiano quando
si incollano i dati, indipendentemente dal fatto che i riferimenti siano relativi o assoluti.

Per copiare e incollare i dati nel foglio di calcolo

1. Spostare il cursore sulla cella da cui copiare i dati.
2. Premere , selezionare [Copy & Paste], quindi premere .

• Si passa allo stato di standby dell’operazione “incolla”. Per annullare
lo standby, premere  o .

3. Spostare il cursore nella cella in cui incollare i dati appena copiati,
quindi premere .
• Lo stato do standby dell’operazione “incolla” rimane attivo fino a

quando si preme  o  per incollare i dati copiati in altre celle.

Nota

• Quando si copia il contenuto di una cella contenente una formula con un riferimento
relativo, questo cambia in base alla posizione della cella in cui si incolla il contenuto.

Come eliminare i dati da una cella specifica

Spostare il cursore nella cella di cui si vuole eliminare il contenuto e
premere .

Come eliminare il contenuto di tutte le celle di un foglio di
calcolo

Premere , selezionare [Delete All], quindi premere .

Utilizzo dei comandi speciali dell’app Spreadsheet
Nell’app Spreadsheet, si possono usare i seguenti comandi all’interno
delle formule o delle costanti. Questi comandi sono disponibili nel menu
che appare quando si preme  e si seleziona [Spreadsheet].
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Min(
Restituisce il valore minimo di un intervallo di celle specificato.
Sintassi: Min(cella iniziale:cella finale)

Max(
Restituisce il valore massimo di un intervallo di celle specificato.
Sintassi: Max(cella iniziale:cella finale)

Mean(
Restituisce la media dei valori di un intervallo di celle specificato.
Sintassi: Mean(cella iniziale:cella finale)

Sum(
Restituisce la somma dei valori di un intervallo di celle specificato.
Sintassi: Sum(cella iniziale:cella finale)

Esempio 3: continuando dall’Esempio 1, inserire nella cella A4 la formula
=Sum(A1:A3) per calcolare la somma delle celle A1, A2 e A3.
1. Spostare il cursore nella cella A4.
2. Inserire =Sum(A1:A3).

(=)  – [Spreadsheet] > [Sum]
(A)

 – [Spreadsheet] > [:]
(A)

3. Premere .

Inserimento in batch della stessa formula o della
stessa costante in più celle

Con le procedure descritte in questa sezione si può inserire la stessa
formula o costante in una specifica serie di celle. Il comando Fill Formula
permette di inserire una formula in batch, mentre con Fill Value si può
inserire una costante in batch.

Nota

• Se la formula o la costante da inserire contiene un riferimento relativo, questo verrà
inserito facendo riferimento alla cella superiore sinistra dell’intervallo specificato. Se la
formula o la costante da inserire contiene un riferimento assoluto, questo verrà inserito
in tutte le celle dell’intervallo specificato.
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Come inserire la stessa formula in batch in una serie di celle

Esempio 4: continuando dall’Esempio 1, inserire in batch nelle celle
B1, B2 e B3 una formula che raddoppia il valore della cella a sinistra,
dopodiché sottrae 3.
1. Spostare il cursore nella cella B1.
2. Premere , selezionare [Fill Formula] e premere .

• Viene visualizzata la schermata Fill Formula.
3. Nella riga “Form”, inserire la formula =2A1-3: 2 (A) 3 .

• Il simbolo di uguale (=) all’inizio non è indispensabile.
4. Nella riga “Range”, specificare B1:B3 come intervallo per l’inserimento

in batch.

5. Per confermare l’inserimento, premere .
• In questo modo si inserirà =2A1-3 nella cella B1, =2A2-3 nella cella

B2 e =2A3-3 nella cella B3.

Come inserire la stessa costante in batch in una serie di celle

Esempio 5: continuando dall’Esempio 4, inserire in batch nelle celle C1,
C2 e C3 valori tripli rispetto a quelli contenuti nelle celle alla loro sinistra.
1. Spostare il cursore nella cella C1.
2. Premere , selezionare [Fill Value] e premere .

• Viene visualizzata la schermata Fill Value.
3. Nella riga “Value”, inserire la costante B1×3: (B) 3 .
4. Nella riga “Range”, specificare C1:C3 come intervallo per l’inserimento

in batch.

5. Per confermare l’inserimento, premere .
• In questo modo, nelle celle C1, C2 e C3 vengono inseriti i valori dei

risultati di ogni calcolo.

98



Parametri delle impostazioni dell’app Spreadsheet
Le seguenti impostazioni sono disponibili nel menu TOOLS.
“◆” indica l’impostazione predefinita iniziale.

Auto Calc
Consente di specificare se le formule devono essere ricalcolate
automaticamente.
On◆: attiva il ricalcolo automatico.
Off: disattiva il ricalcolo automatico.

Show Cell
Consente di specificare se la formula presente nel riquadro di modifica
deve essere visualizzata così com’è oppure se visualizzare il risultato del
calcolo.
Formula◆: visualizza la formula così com’è.
Value: visualizza il risultato del calcolo della formula.

Auto Calc e Recalculate
“Auto Calc” è una voce delle impostazioni del menu TOOLS (consultare la
sezione “Parametri delle impostazioni dell’app Spreadsheet” (pagina
99)).
Con l’impostazione predefinita iniziale dell’app Spreadsheet, (Auto Calc:
On), le formule presenti in una cella vengono automaticamente ricalcolate
ogni volta che si modifica il contenuto della cella. In base al contenuto
del foglio di calcolo, il ricalcolo automatico può richiedere un certo tempo.
Quando la funzione Auto Calc è disabilitata (Off), è necessario eseguire il
ricalcolo manualmente.

Per eseguire il ricalcolo manualmente

Premere , selezionare [Recalculate], quindi premere .

Nota

• Anche se l’impostazione Auto Calc è impostata su On, è necessario eseguire la
funzione [Recalculate] nei seguenti casi.
- Quando si utilizza il menu SETTINGS per modificare l’impostazione Angle Unit
- Quando una cella contiene una formula con la funzione “f(” o “g(” e la corrispondente

equazione caratteristica (f(x) o g(x)) viene aggiornata
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- Quando una cella contiene una formula con una variabile e la variabile
corrispondente viene aggiornata

Creazione di una tabella numerica
L’app Table consente di creare una tabella numerica basata sulle
equazioni caratteristiche registrate per le funzioni f(x) e g(x).

Procedura generale per la creazione di una tabella
numerica

Esempio: generare una tabella numerica per le funzioni f(x) = x2 + 1
2  e

g(x) = x2 - 1
2  nell’intervallo -1 ≤ x ≤ 1, con incrementi di 0,5

1. Premere , selezionare l’icona dell’app Table, quindi premere .
• Viene visualizzata la schermata della tabella numerica.
• Se un’equazione caratteristica non è registrata per f(x) o g(x) o

ambedue e non ci sono dati nella posizione di selezione del cursore,
nella parte inferiore della schermata verrà visualizzato un messaggio
indicante che l’equazione caratteristica non è registrata.

2. Configurare le impostazioni per generare una tabella numerica partendo
da due funzioni.
(1) Premere , quindi selezionare [Table Type] > [f(x)/g(x)].
(2) Premere .
• Per informazioni sulle impostazioni, consultare la sezione “Numero

massimo di righe in una tabella numerica in base al parametro
Table Type” (pagina 101).

3. Registrare un’equazione caratteristica per f(x).

 – [Define f(x)/g(x)] > [Define f(x)]
1 2

(schermata visualizzata immediatamente prima di premere )

4. Registrare un’equazione caratteristica per g(x).

 – [Define f(x)/g(x)] > [Define g(x)]
1 2

(schermata visualizzata immediatamente prima di premere )
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• Si può usare anche , per registrare un equazione caratteristica.
Per ulteriori informazioni, consultare la sezione “Equazione
caratteristica – Registrazione” (pagina 102).

5. Configurare l’intervallo della tabella numerica.

 – [Table Range]
((-))1 1 0 5

6. Premere .
• Il risultato viene visualizzato nella schermata della tabella numerica.

• L’elaborazione della tabella numerica comporta la modifica del
contenuto della variabile x.

Nota

• Nella schermata della tabella numerica è possibile memorizzare in una variabile il
valore di una cella. Ad esempio, eseguendo la seguente operazione mentre è visibile
la schermata di cui alla fase 6, il valore -1 verrà memorizzato nella variabile A: 
– [A=] > [Store]. Per informazioni dettagliate sulle variabili, consultare la sezione
“Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).

Numero massimo di righe in una tabella numerica
in base al parametro Table Type

È possibile configurare le impostazioni della schermata della tabella
numerica in modo da visualizzare le colonne per f(x) o per g(x) o per
ambedue. A questo scopo, utilizzare il menu visualizzato quando si preme

 – [Table Type] mentre è visibile la schermata della tabella numerica.

f(x)/g(x) ... Consente di visualizzare entrambe le colonne f(x) e g(x)
(impostazione predefinita iniziale)
f(x) ... Consente di visualizzare solo la colonna f(x)
g(x) ... Consente di visualizzare solo la colonna g(x)

Il numero massimo di righe nella tabella numerica generata dipende
dall’impostazione Table Type. Sono supportate fino a 45 righe per le
impostazioni “f(x)” e “g(x)”, oppure 30 righe per l’impostazione “f(x)/g(x)”.
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Equazione caratteristica – Registrazione
Le equazioni caratteristiche per f(x) e g(x) si possono registrare in due
modi.
• Quando è visibile la schermata della tabella numerica dell’app Table, si

può registrare un’equazione premendo 
 – [Define f(x)/g(x)] > [Define f(x)]
 – [Define f(x)/g(x)] > [Define g(x)]

• Quando è visibile la schermata della tabella numerica dell’app Table o
mentre è in uso si qualsiasi app della calcolatrice tranne Distribution,
Equation (Simul Equation / Polynomial), Inequality, Base-N, Ratio e
Math Box, si può registrare un’equazione premendo 

 – [Define f(x)]
 – [Define g(x)]

Viene visualizzata la stessa schermata di registrazione delle equazioni
f(x) o g(x), indipendentemente dall’operazione scelta per registrare le
equazioni caratteristiche.

Nota

• Per i dettagli sulle operazioni con , consultare la sezione “Registrazione e utilizzo
delle equazioni caratteristiche per f(x) e g(x)” (pagina 64).

Modifica dei dati nella schermata di una tabella
numerica

Eliminazione di una riga

1. Nella schermata della tabella numerica, spostare il cursore sulla riga da
eliminare.

2. Premere .

Inserimento di una riga

1. Nella schermata della tabella numerica, spostare il cursore nella riga
che si troverà sotto la riga da inserire.

2. Eseguire la seguente operazione:  – [Edit] > [Insert Row].

Eliminazione di tutto il contenuto della schermata della tabella
numeri

Nella schermata della tabella numerica, procedere come segue:  –
[Edit] > [Delete All].
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Modifica del valore inserito in una cella della colonna x

È possibile modificare il valore presente nella cella x attualmente
evidenziata. Modificando il valore x, i valori f(x) e g(x) nella stessa riga
vengono aggiornati di conseguenza.

Inserimento di un valore nella cella evidenziata della colonna
x: {valore della cella soprastante} +/- {valore dell’incremento}

Se nella cella x sopra la cella x evidenziata è presente un valore,
premendo  o  viene automaticamente inserito nella cella evidenziata
un valore uguale a quello della cella sopra di essa, aumentato del valore
dell’incremento. Analogamente, premendo  viene automaticamente
inserito un valore uguale a quello della cella soprastante, diminuito del
valore dell’incremento. I valori f(x) e g(x) nella stessa riga vengono
aggiornati di conseguenza.

Tempi di aggiornamento per f(x) e g(x)
I valori di f(x) e g(x) visualizzati nella schermata della tabella numerica
vengono aggiornati quando si verifica una delle seguenti condizioni.
• Quando si preme  mentre l’opzione [Execute] è selezionata nella

schermata Table Range.
• Quando le equazioni caratteristiche di f(x) e g(x) vengono aggiornate

(con l’eccezione dei casi in cui l’equazione caratteristica è una funzione
composta).

• Quando si inserisce un numero nella colonna x (anche premendo ,
,  nella colonna x).

Tenere presente però che i valori non vengono aggiornati
automaticamente dopo le seguenti operazioni.
• Quando si utilizza il menu SETTINGS per modificare l’impostazione

Angle Unit.
• Quando la variabile di un’equazione caratteristica viene aggiornata

(nuovo valore numerico memorizzato) in occasione della registrazione
di un’equazione caratteristica contenente una variabile (esempio: f(x) =
2x + A).

• Quando si registra l’equazione caratteristica di una funzione composta
(esempio: g(x) = f(x) × 2 - x) e l’equazione caratteristica della funzione di
riferimento (esempio: f(x) di g(x) = f(x) × 2 - x) viene aggiornata (nuova
equazione caratteristica registrata).

In questi casi, per aggiornare i valori eseguire  – [Recalculate] mentre è
visibile la schermata della tabella numerica.
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Conservazione dei dati
Le seguenti operazioni determinano l’eliminazione di alcuni dati e la
cancellazione di alcune impostazioni dell’app Table.① Ritorno alla schermata HOME e avvio di un’altra app della

calcolatrice.② Pressione di .③ Modifica dell’impostazione Input/Output con il menu SETTINGS.④ Modifica dell’impostazione Table Type con il menu TOOLS.
La tabella seguente mostra quali dati vengono eliminati e quali sono
conservati.

Operazione ① ② ③ ④
Dati tabella numerica
(colonne x, f(x), g(x)) Eliminato Eliminato Eliminato Eliminato

Impostazioni Table
Range Eliminato Conservato Conservato Conservato

Impostazioni Table
Type Conservato Conservato Conservato --

Equazioni
caratteristiche f(x), g(x) Conservato Eliminato Eliminato Conservato

Calcolo di equazioni
L’app Equation include le tre funzioni descritte di seguito. Dopo aver
avviato l’app, il menu Equation visualizzato consente di selezionare la
funzione desiderata.

Simul Equation: equazioni lineari simultanee con due-quattro incognite
Polynomial: equazioni di ordine superiore, dal 2° al 4° grado
Solver: funzione che consente di ricavare il valore di qualsiasi variabile
contenuta in un’equazione inserita

Equazioni lineari simultanee
Qui viene descritta la procedura generale per risolvere un’equazione
simultanea, con un esempio in cui si risolve un’equazione lineare
simultanea con tre incognite.
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Esempio 1: 

1. Premere , selezionare l’icona dell’app Equation, quindi premere .
• Verrà visualizzato il menu Equation.

2. Selezionare [Simul Equation], quindi premere .
• Viene visualizzato il menu del numero di incognite.

3. Selezionare [3 Unknowns], quindi premere .
• Viene visualizzato l’editor dei coefficienti.

4. Utilizzare l’editor dei coefficienti per inserire i valori dei coefficienti.

1 ((-))1 1 2
1 1 ((-))1 0

((-))1 1 1 4

• Premendo  mentre è visualizzato l’editor dei coefficienti, tutti i
coefficienti vengono azzerati.

5. Premere .
• Verrà visualizzata una soluzione.

• Quando l’indicatore  è visibile, ogni volta che si preme  (o )
viene visualizzata un’altra soluzione.

 (oppure )
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 (oppure )

• Premendo  o  mentre l’indicatore  è visibile, viene riproposta la
soluzione visualizzata in precedenza.

• Premendo  mentre è visibile la soluzione finale si torna all’editor dei
coefficienti. Per tornare all’editor dei coefficienti quando è visualizzata
una soluzione, premere .

• Premendo  mentre è visualizzato l’editor dei coefficienti si torna al
menu del numero di incognite.

Nota

• Quando è visibile l’editor dei coefficienti è possibile memorizzare in una variabile il
valore attualmente evidenziato. Inoltre, quando è visibile una soluzione, è possibile
memorizzarla in una variabile. Per informazioni dettagliate sulle variabili, consultare la
sezione “Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).

Equazioni di ordine superiore, dal 2° al 4° grado
Quando si risolve un’equazione di ordine superiore con l’app Equation,
vengono visualizzati i valori riportati di seguito in base al grado
dell’equazione.

• Equazione di secondo grado
Dopo la visualizzazione della soluzione di ax2+bx+c=0, vengono
visualizzate le coordinate del minimo (o del massimo) (x, y) per y=ax2

+bx+c.

• Equazione cubica
Dopo la visualizzazione della soluzione di ax3+bx2+cx+d=0, vengono
visualizzate le coordinate (x, y) del minimo locale (o del massimo locale)
di y= a x3+bx2+cx+d, solo se esiste un minimo locale o un massimo
locale. Se non esiste un minimo o un massimo locale, premendo 
mentre è visibile l’ultima soluzione verrà visualizzato il messaggio “No
Local Max/Min”.

• Equazione di quarto grado
Viene visualizzata la soluzione di ax4+bx3+cx2+dx+e=0.

Qui mostreremo un esempio di equazione di secondo grado per spiegare
la procedura generale che consente di risolvere le equazioni di ordine
superiore.

Esempio 2: x2 + 2x − 2 = 0

106



(Input/Output: MathI/MathO)
1. Premere , selezionare l’icona dell’app Equation, quindi premere .

• Verrà visualizzato il menu Equation.

2. Selezionare [Polynomial], quindi premere .
• Viene visualizzato il menu del numero di gradi.

3. Selezionare [ax2+bx+c], quindi premere .
• Viene visualizzato l’editor dei coefficienti.

4. Utilizzare l’editor dei coefficienti per inserire i valori dei coefficienti.

1 2 ((-))2

• Premendo  mentre è visualizzato l’editor dei coefficienti, tutti i
coefficienti vengono azzerati.

5. Premere .
• Verrà visualizzata una soluzione.

• Quando l’indicatore  è visibile, ogni volta che si preme  (o )
viene visualizzato un altro risultato (soluzione o coordinata).

 (oppure )

(Visualizza la coordinata x del minimo di y = x2 + 2x − 2.)
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 (oppure )

(Visualizza la coordinata y del minimo di y = x2 + 2x − 2.)

 (oppure )

• Premendo  o  mentre l’indicatore  è visibile, viene riproposto il
risultato visualizzato in precedenza.

• Premendo  mentre è visibile il risultato finale del calcolo si torna
all’editor dei coefficienti. Per tornare all’editor dei coefficienti quando è
visualizzato qualsiasi risultato del calcolo, premere .

• Premendo  mentre è visualizzato l’editor dei coefficienti si torna al
menu del numero di gradi.

Nota

• Quando è visibile l’editor dei coefficienti è possibile memorizzare in una variabile
il valore attualmente evidenziato. Inoltre, quando un risultato del calcolo (soluzione
o coordinata) è visibile, è possibile memorizzarlo in una variabile. Per informazioni
dettagliate sulle variabili, consultare la sezione “Variabili (A, B, C, D, E, F, x, y, z)”
(pagina 39).

Visualizzazione di soluzioni di numeri complessi (Complex
Roots)

Le equazioni di ordine superiore possono avere soluzioni che
appartengono ai numeri complessi. Quando l’opzione Polynomial è
selezionata nel menu Equation, con le seguenti operazioni si può abilitare
o disabilitare la visualizzazione delle soluzioni di numeri complessi.

 – [Complex Roots] > [On] 
Consente di abilitare la visualizzazione delle soluzioni di numeri
complessi (impostazione predefinita iniziale).

 – [Complex Roots] > [Off] 
Consente di disabilitare la visualizzazione delle soluzioni di numeri
complessi. L’inserimento e l’esecuzione di un’equazione che ha una
o più soluzioni appartenenti ai numeri complessi determinerà solo la
visualizzazione del messaggio “No Real Roots”.

Esempio 3: 2x2 + 3x + 4 = 0
(Input/Output: MathI/MathO, Complex Result: a+bi, Complex Roots: On)

108



1. Premere , selezionare l’icona dell’app Equation, quindi premere .
• Verrà visualizzato il menu Equation.

2. Selezionare [Polynomial] > [ax2+bx+c].
• Viene visualizzato l’editor dei coefficienti.

3. Utilizzare l’editor dei coefficienti per inserire i valori dei coefficienti.

2 3 4

4. Premere .
• Verrà visualizzata una soluzione.

5. Visualizzare un’altra soluzione e i valori delle coordinate.

 (oppure )

 (oppure )

 (oppure )

• Premendo  mentre è visibile il risultato finale del calcolo si torna
all’editor dei coefficienti. Per tornare all’editor dei coefficienti quando è
visualizzato qualsiasi risultato del calcolo, premere .

109



Conversione di una soluzione di numeri complessi in
coordinate cartesiane o polari

Il menu FORMAT visualizzato quando si preme  consente di convertire
una soluzione di numeri complessi in coordinate cartesiane o in coordinate
polari.

Esempio 4: convertire la soluzione dei numeri complessi visualizzata
nell’Esempio 3 (pagina 108) in coordinate polari, quindi in coordinate
cartesiane
1. Eseguire i passaggi da 1 a 4 dell’Esempio 3 (pagina 108).

2. Premere , selezionare [Polar Coord], quindi premere .
• La soluzione viene convertita nel formato delle coordinate polari.

3. Premere , selezionare [Rectangular Coord], quindi premere .
• La soluzione viene convertita nel formato delle coordinate cartesiane.

Utilizzo dell’operazione Solver
L’operazione Solver utilizza il metodo di Newton per approssimare la
soluzione delle equazioni. Solver supporta l’inserimento di equazioni nei
seguenti formati.
Esempi: y = x + 5, x = sin(A), xy + C (trattato come xy + C = 0)

Esempio 5: risolvere x2 - B
2  = 0 per x quando B = 4

(Input/Output: MathI/MathO)

Nota

• Prima di risolvere x2 - B
2  = 0 per x, occorre memorizzare il valore 4 nella variabile B.

Lo faremo nella fase 3 della seguente procedura.

1. Premere , selezionare l’icona dell’app Equation, quindi premere .
• Verrà visualizzato il menu Equation.
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2. Selezionare [Solver], quindi premere .
• Viene visualizzata la schermata di inserimento dell’equazione Solver.

3. Memorizzare 4 nella variabile B.

4

• Questa operazione si può eseguire in qualsiasi momento prima della
fase 7 di questa procedura.

• Per informazioni dettagliate sulle variabili, consultare la sezione
“Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).

• Premere  per tornare alla schermata di inserimento dell’equazione
Solver.

4. Inserire l’equazione.

(B) 2
(=)*0

* Anche la seguente operazione consente di inserire il segno “=”:  –
[Equation] > [=].

5. Premere  per registrare l’equazione inserita.
6. Nella schermata Solve Target visualizzata, confermare che [x] è stato

selezionato e premere .
• Viene visualizzata una schermata con il valore iniziale di x.

7. Inserire 1 come valore iniziale di x.

1

8. Dopo aver verificato che [Execute] è selezionato, premere  per
risolvere l’equazione.

(1) Variabile risolta per
(2) Soluzione
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(3) risultato (Lato sinistro) − (Lato destro)

• Le soluzioni vengono sempre visualizzate in formato decimale.
• Quanto più il risultato (Lato sinistro) − (Lato destro) si avvicina a zero,

tanto più precisa è la soluzione.
9. A questo punto, premere il tasto corrispondente all’operazione

desiderata.

Per questa operazione:
Premere questo
tasto:

Tornare alla schermata della fase 6. *

Memorizzare l’espressione inserita e tornare
alla schermata della fase 4.

 oppure 

* Quando si preme questo tasto il valore iniziale diventa l’ultimo valore
utilizzato per il calcolo.

Importante!

• L’operazione Solver esegue la convergenza un
numero predefinito di volte. Se non viene trovata
una soluzione, appare una schermata di conferma,
come quella riportata qui accanto, in cui si chiede
se si desidera continuare. Premere  mentre
è selezionata l’opzione [Continue] per continuare,
oppure selezionare [Exit], quindi  per annullare
l’operazione Solver.

• A seconda del valore iniziale inserito per la variabile della soluzione (x nell’esempio
precedente), Solver potrebbe non essere in grado di fornire una soluzione. In questo
caso, provare a modificare il valore iniziale affinché sia più vicino alla soluzione.

• Solver potrebbe non essere in grado di determinare la soluzione corretta, anche se ne
esiste una.

• Solver utilizza il metodo di Newton, quindi anche qualora esistano più soluzioni, ne
verrà restituita solo una.

• A causa dei limiti del metodo di Newton, le soluzioni tendono ad essere difficili da
ottenere per equazioni come le seguenti: y=sinx, y=ex, y=√x.

Calcolo disuguaglianza
L’app Inequality consente di risolvere disequazioni di 2°, 3°, o 4° grado.
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Procedura generale per eseguire un calcolo di
disequazioni

Esempio 1: risolvere x2 + 2x - 3 ≥ 0
1. Premere , selezionare l’icona dell’app Inequality, quindi premere .

• Viene visualizzato il menu del numero di gradi.

2. Selezionare [ax2+bx+c], quindi premere .

3. Nel menu visualizzato, selezionare il tipo e l’orientamento del simbolo di
disuguaglianza (>, <, ≥, ≤).
• Qui vogliamo risolvere x2 + 2x - 3 ≥ 0; selezionare [ax2+bx+c≥0], quindi

premere .
4. Nell’editor dei coefficienti che viene visualizzato, inserire i valori del

coefficiente.

1 2 ((-))3

5. Premere .
• Verrà visualizzata la soluzione.

• Per tornare all’editor dei coefficienti, mentre la soluzione è
visualizzata, premere ,  o .

• Premendo  mentre è visualizzato l’editor dei coefficienti si torna al
menu della fase 2.

• Premendo  mentre viene visualizzato il menu della fase 2 si torna
al menu del numero di gradi.

Nota

• Quando si seleziona un valore diverso da MathI/MathO per l’impostazione Input/
Output nel menu SETTINGS, le soluzioni vengono visualizzate come mostrato nella
schermata qui sotto.
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• Se per una disequazione non esistono soluzioni (ad esempio per x2 < 0), nella
schermata delle soluzioni viene visualizzata l’indicazione “No Solution”.

• Se la soluzione di una disequazione è costituita da tutti i numeri (ad esempio per x2 ≥
0), nella schermata delle soluzioni viene visualizzata l’indicazione “All Real Numbers”.

Calcolo di numeri complessi
Per i calcoli di numeri complessi, avviare prima l’app Complex.
Premere , selezionare l’icona dell’app Complex, quindi premere .

Inserimento di numeri complessi
Per inserire numeri complessi si possono usare le coordinate cartesiane
(a+bi) o le coordinate polari (r∠θ).

Esempio 1: inserire 2+3i

2 3 (i)*

* Anche la seguente operazione consente di inserire i:  – [Complex] >
[i].

Esempio 2: inserire 5∠30

5  – [Complex] > [∠] 30

Esempi di calcolo con l’app Complex

Prima di eseguire le operazioni di esempio

• Per gli esempi riportati in questa sezione, accedere al menu SETTINGS
e selezionare il valore MathI/MathO per l’impostazione Input/Output.
Configurare le altre impostazioni come mostrato per ogni esempio.

• I risultati dei calcoli dei numeri complessi vengono visualizzati in base
all’impostazione Complex Result nel menu SETTINGS.

• Se si prevede di inserire i valori e di visualizzare i risultati dei calcoli
come coordinate polari, specificare il valore Angle Unit nel menu
SETTINGS prima di iniziare il calcolo.

• Il valore θ del risultato del calcolo viene visualizzato nell’intervallo -180°
< θ ≤ 180°.

• Quando si seleziona un valore diverso da MathI/MathO, i risultati dei
calcoli saranno visualizzati con a e bi (o r e θ) in righe separate.
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Esempio 3: (1 + i)4 + (1 - i)2 = -4 - 2i
(Complex Result: a+bi)

1 (i) 4
1 (i)

Nota

• Quando si eleva a una potenza intera un numero complesso utilizzando la sintassi
(a+bi)n, il valore della potenza può essere compreso nel seguente intervallo: -1 × 1010

< n < 1 × 1010.

Esempio 4: 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2  – [Complex] > [∠] 45

Esempio 5: √2 + √2i = 2∠45
(Angle Unit: Degree, Complex Result: r∠θ)

2 2 (i)

Esempio 6: ottenere il numero complesso coniugato di 2 + 3i
(Complex Result: a+bi)

 – [Complex] > [Conjugate]
2 3 (i)

Esempio 7: ottenere il valore assoluto e l’argomento 1 + i
(Angle Unit: Degree)

 – [Numeric Calc] > [Absolute Value]
1 (i)

 – [Complex] > [Argument]
1 (i)
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Esempio 8: estrarre la parte reale e la parte immaginaria di 2 + 3i

 – [Complex] > [Real Part]
2 3 (i)

 – [Complex] > [Imaginary Part]
2 3 (i)

Conversione del risultato del calcolo di un numero complesso
in coordinate cartesiane o polari

Il menu FORMAT, visualizzato quando si preme , consente di convertire
il risultato del calcolo di un numero complesso in coordinate cartesiane o
in coordinate polari.

Esempio 9: √2 + √2i = 2∠45, 2∠45 = √2 + √2i
(Angle Unit: Degree, Complex Result: a+bi)

2 2 (i)

 – [Polar Coord]

 – [Rectangular Coord]

Calcoli in base n
Per eseguire calcoli con valori decimali, esadecimali, binari e/o ottali,
avviare l’app Base-N. Premere , selezionare l’icona dell’app Base-N,
quindi premere . Il sistema di numerazione predefinito, all’avvio dell’app
Base-N, è quello decimale.
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Dopo aver avviato l’app Base-N, il tasto  consente di cambiare il
sistema di numerazione.
Ogni pressione di  consente di passare al sistema di numerazione
successivo, come mostrato di seguito.

(1) [Decimal]  (2) [Hexadecimal]  (3) [Binary]  (4) [Octal]

Nota

• I pedici accanto ai valori mostrati negli esempi indicano la base (sistema di
numerazione) di ciascun valore.
Esempio: 12 ... Binario 1; 116 ... Esadecimale 1

Esempio 1: calcolare 112 + 12

1. Premere  per passare al sistema di numerazione [Binary].
2. Eseguire il calcolo 112 + 12.

11 1

Esempio 2: calcolare 1F16 + 116 in esadecimale
1. Premere  per passare al sistema di numerazione [Hexadecimal].
2. Eseguire il calcolo 1F16 + 116.

1 (F) 1

Nota

• I seguenti tasti consentono di inserire le lettere da A a F, per i valori esadecimali: 
(A), (B), (C), (D), (E), (F). I valori esadecimali si

possono inserire anche utilizzando le voci del menu CATALOG mostrate di seguito.
 – [Hex Value] > [A], [B], [C], [D], [E], o [F]

• Nota: se si inserisce un carattere compreso tra A e F con l’operazione riportata di
seguito, il carattere sarà considerato come il nome di una variabile, non come un
valore esadecimale.
(1) Premere  per visualizzare la schermata dell’elenco delle variabili.
(2) Selezionare [A=], [B=], [C=], [D=], [E=] o [F=], quindi premere .
(3) Nel menu visualizzato, selezionare [Recall].

• L’app Base-N non è supporta l’inserimento di valori frazionari (decimali) ed esponenti.
Se il risultato di un calcolo ha una parte frazionaria, questa viene rimossa.

• I dettagli sugli intervalli di inserimento e di uscita (32 bit) sono riportati qui di seguito.•
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Base Intervallo

Binaria

Positivo: 00000000000000000000000000000000 ≤ x ≤
01111111111111111111111111111111
Negativo: 10000000000000000000000000000000 ≤ x ≤
11111111111111111111111111111111

Ottale
Positivo: 00000000000 ≤ x ≤ 17777777777
Negativo: 20000000000 ≤ x ≤ 37777777777

Decimale -2147483648 ≤ x ≤ 2147483647

Esadecimale
Positivo: 00000000 ≤ x ≤ 7FFFFFFF
Negativo: 80000000 ≤ x ≤ FFFFFFFF

• Se il risultato di un calcolo non rientra nell’intervallo applicabile per il sistema di
numerazione in uso, si verifica un Math ERROR.

Determinazione del sistema di numerazione di uno
specifico valore in ingresso

È possibile inserire un comando speciale immediatamente prima di un
valore per specificarne il sistema di numerazione. I comandi speciali sono:
d (decimale), h (esadecimale), b (binario) e o (ottale).

Esempio 3: calcolare 1010 + 1016 + 102 + 108 e visualizzare il risultato
come valore decimale
1. Premere  per passare al sistema di numerazione [Decimal].
2. Eseguire il calcolo 1010 + 1016 + 102 + 108.

 – [Base Prefix] > [Decimal(d)] 10
 – [Base Prefix] > [Hexadecimal(h)] 10

 – [Base Prefix] > [Binary(b)] 10
 – [Base Prefix] > [Octal(o)] 10

Conversione di un risultato di calcolo in un altro
tipo di valore

Il tasto  consente di convertire il risultato del calcolo attualmente
visualizzato in un valore di altro tipo.

Esempio 4: calcolare 1510 × 3710 in decimale, quindi convertire il risultato
in esadecimale
1. Premere  per passare al sistema di numerazione [Decimal].
2. Eseguire il calcolo 1510 × 3710.

15 37
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3. Premere  per passare al sistema di numerazione [Hexadecimal].

Operazioni logiche e di negazione
Le operazioni logiche e di negazione si eseguono premendo 
e selezionando [Logic Operation], quindi selezionando il comando
opportuno (Neg, Not, and, or, xor, xnor) nel menu visualizzato. Tutti gli
esempi qui di seguito sono eseguiti nel sistema binario.

Esempio 5: determinare l’AND logico di 10102 e 11002 (10102 and 11002)

1010
 – [Logic Operation] > [and]

1100

Esempio 6: determinare il complemento bit per bit di 10102 (Not(10102))

 – [Logic Operation] > [Not]
1010

Nota

• Nel caso di un valore binario, ottale o esadecimale negativo, la calcolatrice converte
il valore in binario, considera il complemento a due, quindi lo riconverte nella base di
numerazione originale. Per i valori decimali, la calcolatrice aggiunge semplicemente il
segno meno.

Calcoli nelle matrici
L’app Matrix consente di eseguire calcoli con matrici contenente fino a 4
righe per 4 colonne.

Procedura generale per eseguire calcoli nelle
matrici

Per eseguire un calcolo di matrici, utilizzare le variabili speciali delle
matrici (MatA, MatB, MatC, MatD), come mostrato nell’esempio seguente.

Esempio 1: calcolare 
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• Per la moltiplicazione (Matrice 1 × Matrice 2), il numero di colonne della
Matrice 1 deve corrispondere al numero di righe della Matrice 2. In caso
contrario si verificherà un errore.

1. Premere , selezionare l’icona dell’app Matrix, quindi premere .
• Viene visualizzata la schermata di calcolo della matrice.

2. Premere .
• Viene visualizzata la schermata dell’elenco delle variabili delle matrici.

• Per i dettagli sul contenuto della schermata dell’elenco delle variabili
delle matrici e su come eseguire operazioni di memorizzazione,
modifica o di altro tipo, consultare la sezione “Schermata dell’elenco
delle variabili delle matrici” (pagina 122).

3. Per memorizzare  in MatA, procedere come segue.

(1) Selezionare [MatA:], quindi premere .
• Viene visualizzata la schermata delle impostazioni delle dimensioni

delle matrici (impostazione predefinita iniziale: 2 righe, 2 colonne).

(2) Qui si vuole memorizzare una matrice 2×2, quindi occorre
selezionare [Confirm] per poi premere .
• Viene visualizzato l’editor delle matrici per l’inserimento degli

elementi della matrice 2×2 per MatA.

(3) Inserire gli elementi di MatA.

2 1 1 1
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(4) Premere ,  o  per tornare alla schermata del calcolo delle
matrici.

4. Per memorizzare  in MatB, procedere come segue.

(1) Premere , selezionare [MatB:], quindi premere .
(2) Selezionare [Confirm], quindi premere .
(3) Inserire gli elementi di MatB.

2 ((-))1 ((-))1 2

(4) Premere ,  o  per tornare alla schermata del calcolo delle
matrici.

5. Inserire MatA×MatB.

 – [Matrix] > [MatA]
 – [Matrix] > [MatB]

6. Premere .
• Viene visualizzata la schermata MatAns (memoria delle risposte delle

matrici) con il risultato del calcolo.

• Per i dettagli su MatAns, consultare la sezione “Memoria delle
risposte nelle matrici (Matrix Answer Memory, MatAns)” (pagina
124).

• Premendo  mentre è aperta la schermata MatAns si torna alla
schermata del calcolo della matrici e si cancella l’espressione da
calcolare. Premendo  o  torna allo stato di completamento
dell’inserimento dell’espressione da calcolare, alla fase 5 di questa
procedura.

Nota

• Quando è visibile la schermata dell’editor delle matrici o la schermata MatAns, è
possibile memorizzare in una variabile il valore evidenziato. Quando è visibile la
schermata del calcolo delle matrici e sullo schermo è presente il risultato del calcolo, è
possibile memorizzare in una variabile tale risultato. Per informazioni dettagliate sulle
variabili, consultare la sezione “Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).
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Schermata dell’elenco delle variabili delle matrici
La schermata dell’elenco delle variabili delle matrici è l’ambiente iniziale
da cui si può memorizzare una matrice nella variabile delle matrici
MatA, MatB, MatC o MatD oppure modificare una matrice memorizzata
in precedenza. Lo stato di ogni variabile della matrice è indicato come
mostrato negli esempi seguenti.

(1) 2×2
Indica che una matrice 2×2 è memorizzata nella variabile della
matrice.

(2) None
Indica che nella variabile della matrice non è stato memorizzato
nulla.

Visualizzazione della schermata dell’elenco delle variabili delle
matrici

In base alla schermata visualizzata, eseguire una delle seguenti
operazioni.
• Quando è visibile la schermata del calcolo delle matrici:

Premere .
• Quando è visibile la schermata dell’editor delle matrici o la schermata

MatAns:
Premere , selezionare [Define Matrix], quindi premere .

Memorizzazione di nuovi dati in una variabile di una matrice

Esempio 2: memorizzare la matrice 2×3 

1. Quando viene visualizzata la schermata del calcolo delle matrici,
premere  per visualizzare la schermata dell’elenco delle variabili delle
matrici.

2. Selezionare la variabile della matrice (MatA, MatB, MatC o MatD) in cui
memorizzare i nuovi dati, quindi premere .
• Se è stata selezionata una variabile con stato “None”, passare alla

fase 4 di questa procedura.
• Se è stata selezionata una variabile nella quale è già memorizzata

una matrice, verrà visualizzata una schermata del menu. Passare alla
fase 3.
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3. Selezionare [Define New], quindi premere .
4. Nella schermata “Matrix Size?” visualizzata, specificare il numero di

righe e colonne nella matrice.

• Per specificare una matrice 2×3, procedere come segue.
(1) Selezionare [Rows], quindi premere . Nel menu visualizzato,

selezionare [2 Rows] e premere .
(2) Selezionare [Columns] e premere . Nel menu visualizzato,

selezionare [3 Columns] e premere .
5. Dopo aver definito le specifiche delle righe e delle colonne, selezionare

[Confirm], quindi premere .
• Viene visualizzato l’editor delle matrici.

6. Inserire gli elementi della variabile della matrice.

1 0 ((-))1
0 ((-))1 1

7. Premere ,  o  per tornare alla schermata del calcolo delle
matrici.

Nota

• Il contenuto delle variabili delle matrici viene conservato anche se si preme ,
si passa a un’altra app o si spegne la calcolatrice. Eseguendo una delle seguenti
operazioni, il contenuto di tutte le variabili delle matrici verrà cancellato.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Modifica dei dati delle variabili delle matrici

1. Quando viene visualizzata la schermata del calcolo delle matrici,
premere  per visualizzare la schermata dell’elenco delle variabili delle
matrici.
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2. Selezionare la variabile della matrice (MatA, MatB, MatC o MatD) da
modificare, quindi premere .

3. Nel menu visualizzato, selezionare [Edit] e premere .
• Viene visualizzato l’editor delle matrici.

4. Con l’editor delle matrici, modificare gli elementi della matrice.
• Spostare il cursore nella cella contenente l’elemento da modificare,

inserire il nuovo valore, quindi premere .
5. Premere ,  o  per tornare alla schermata del calcolo delle

matrici.

Copia del contenuto delle variabili delle matrici (o MatAns)

1. Visualizzare la schermata dell’editor delle matrici o la schermata
MatAns della variabile della matrice da usare come origine per la copia.
• Per visualizzare l’editor delle matrici, eseguire le fasi 1, 2 e 3 descritte

nella sezione “Modifica dei dati delle variabili delle matrici”
(pagina 123).

• Per visualizzare la schermata MatAns, utilizzare la seguente
procedura mentre è visualizzata la schermata di calcolo delle matrici.

 – [Matrix] > [MatAns] 
2. Selezionare la destinazione della copia della variabile della matrice.

• Ad esempio, per copiarla in MatD, procedere come segue:  –
[Store] > [MatD].

• Viene visualizzato l’editor delle matrici con il contenuto della
destinazione della copia.

3. Premere ,  o  per tornare alla schermata del calcolo delle
matrici.

Memoria delle risposte nelle matrici (Matrix
Answer Memory, MatAns)

Ogni volta che il risultato di un calcolo eseguito nell’app MAtrix è una
matrice, viene visualizzata la schermata MatAns con il risultato. Il risultato
sarà anche memorizzato in una variabile chiamata “MatAns”.

La variabile MatAns si può usare nei calcoli come descritto di seguito.
• Per inserire la variabile MatAns in un calcolo, procedere come segue:

 – [Matrix] > [MatAns].
• Premendo uno dei seguenti tasti mentre è visualizzata la schermata

MatAns, si passa automaticamente alla schermata del calcolo delle
matrici, con “MatAns” seguito dall’operatore o dalla funzione del tasto
premuto: , , , , , , , ( ), ( ).
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Nota

• Il contenuto di MatAns viene conservato anche se si preme  o si spegne la
calcolatrice. Eseguendo una delle seguenti operazioni, il contenuto di MatAns verrà
cancellato.
- Ritorno alla schermata HOME e avvio di un’altra app della calcolatrice
- Esecuzione di  – [Reset] > [Settings & Data]
- Esecuzione di  – [Reset] > [Initialize All]

Esempi di calcolo nelle matrici

Nei seguenti esempi si utilizza MatA = , MatB = , MatC =

, MatD = .

Esempio 3: aggiungere due matrici (MatA + MatB)

 – [Matrix] > [MatA]
  – [Matrix] > [MatB] 

Nota

• Per poter eseguire somme o sottrazioni, le due matrici devono avere le stesse
dimensioni. Se si tenta di sommare o sottrarre matrici con dimensioni diverse si
verifica un errore.

Esempio 4: elevare al quadrato e al cubo MatA (MatA2, MatA3)

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Squared]

 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Matrix Cubed]

Esempio 5: invertire MatA (MatA-1)
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 – [Matrix] > [MatA]  – [Matrix] >
[Matrix Calc] > [Inverse Matrix]

Nota

• È possibile invertire solo le matrici quadrate (stesso numero di righe e colonne). Se si
cerca di invertire una matrice non quadrata si verifica un errore.

• Le matrici con un determinante pari a zero non possono essere invertite. Se si cerca
di invertire una matrice con determinante pari a zero si verifica un errore.

• Per le matrici con determinante è vicino allo zero, la precisione del calcolo è inferiore.

Esempio 6: ottenere il determinante di MatA (Det(MatA))

 – [Matrix] > [Matrix Calc] >
[Determinant]  – [Matrix] > [MatA]

Nota

• I determinanti si possono ricavare solo per le matrici quadrate (stesso numero di righe
e colonne). Se si cerca di ricavare il determinante di una matrice non quadrata si
verifica un errore.

Esempio 7: ottenere la trasposizione di MatC (Trn(MatC))
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 – [Matrix] > [Matrix Calc] >
[Transposition]  – [Matrix] > [MatC]

Esempio 8: creare una matrice identità 2 × 2 e aggiungerla a MatA
(Identity(2) + MatA)

 – [Matrix] > [Matrix Calc] > [Identity]
2   – [Matrix] > [MatA]

Nota

• Come argomento del comando Identity si può specificare un valore compreso tra 1 e 4
(numero di dimensioni).

Esempio 9: ottenere il valore assoluto di ogni elemento di MatC
(Abs(MatC))

 – [Numeric Calc] > [Absolute Value]
 – [Matrix] > [MatC]

Calcoli vettoriali
L’app Vector consente di eseguire calcoli vettoriali bidimensionali e
tridimensionali.

Procedura generale per eseguire calcoli vettoriali
Per eseguire un calcolo vettoriale, utilizzare le variabili vettoriali speciali
(VctA, VctB, VctC, VctD), come mostrato nell’esempio seguente.

Esempio 1: calcolare (1, 2) + (3, 4)
• Quando si eseguono addizioni o sottrazioni di due vettori, essi devono

avere le stesse dimensioni.
1. Premere , selezionare l’icona dell’app Vector, quindi premere .

• Viene visualizzata la schermata del calcolo vettoriale.

2. Premere .
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• Viene visualizzata la schermata dell’elenco delle variabili vettoriali.

• Per i dettagli sul contenuto della schermata dell’elenco delle variabili
vettoriali e su come eseguire operazioni di memorizzazione, modifica
o di altro tipo, consultare la sezione “Schermata dell’elenco delle
variabili vettoriali” (pagina 129).

3. La seguente procedura permette di memorizzare (1, 2) in VctA.
(1) Selezionare [VctA:], quindi premere .

• Viene visualizzata la schermata delle impostazioni delle
dimensioni dei vettori (impostazione predefinita iniziale: 2
dimensioni).

(2) Qui si vuole memorizzare un vettore bidimensionale, quindi occorre
selezionare [Confirm] per poi premere .

• Viene visualizzato l’editor vettoriale, per l’inserimento del vettore
bidimensionale per VctA.

(3) Inserire gli elementi di VctA.

1 2

(4) Premere ,  o  per tornare alla schermata del calcolo
vettoriale.

4. La seguente procedura permette di memorizzare (3, 4) in VctB.
(1) Premere , selezionare [VctB:], quindi premere .
(2) Selezionare [Confirm], quindi premere .
(3) Inserire gli elementi di VctB.

3 4
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(4) Premere ,  o  per tornare alla schermata del calcolo
vettoriale.

5. Inserimento di VctA+VctB.

 – [Vector] > [VctA]
 – [Vector] > [VctB]

6. Premere .
• Viene visualizzata la schermata VctAns (memoria delle risposte

vettoriali) con il risultato del calcolo.

• Per i dettagli su VctAns, consultare la sezione “Memoria delle
risposte vettoriali (Vector Answer Memory, VctAns)” (pagina
132).

• Premendo  mentre è aperta la schermata VctAns si torna alla
schermata del calcolo vettoriale e si cancella l’espressione da
calcolare. Premendo  o  torna allo stato di completamento
dell’inserimento dell’espressione da calcolare, alla fase 5 di questa
procedura.

Nota

• Quando è visibile la schermata dell’editor vettoriale o la schermata VctAns, è possibile
memorizzare in una variabile il valore evidenziato. Quando è visibile la schermata
del calcolo vettoriale e sullo schermo è presente il risultato del calcolo, è possibile
memorizzare in una variabile tale risultato. Per informazioni dettagliate sulle variabili,
consultare la sezione “Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).

Schermata dell’elenco delle variabili vettoriali
La schermata dell’elenco delle variabili vettoriali è l’ambiente iniziale da cui
si può memorizzare un vettore nella variabile vettoriale VctA, VctB, VctC o
VctD oppure modificare un vettore memorizzato in precedenza. Lo stato di
ogni variabile vettoriale è indicato come mostrato negli esempi seguenti.

(1) 2
Indica che nella variabile vettoriale è memorizzato un vettore
bidimensionale.
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(2) None
Indica che nella variabile vettoriale non è stato memorizzato nulla.

Visualizzazione della schermata dell’elenco delle variabili
vettoriali

In base alla schermata visualizzata, eseguire una delle seguenti
operazioni.
• Quando è visibile la schermata del calcolo vettoriale:

Premere .
• Quando è visibile la schermata dell’editor vettoriale o la schermata

VctAns:
Premere , selezionare [Define Vector], quindi premere .

Memorizzazione di nuovi dati in una variabile vettoriale

Esempio 2: memorizzare il vettore tridimensionale (1, 2, 3)
1. Quando viene visualizzata la schermata del calcolo vettoriale, premere

 per visualizzare la schermata dell’elenco delle variabili vettoriali.
2. Selezionare la variabile vettoriale (VctA, VctB, VctC o VctD) in cui

memorizzare i nuovi dati, quindi premere .
• Se è stata selezionata una variabile vettoriale con stato “None”,

passare alla fase 4 di questa procedura.
• Se è stata selezionata una variabile vettoriale nella quale è già

memorizzato un vettore, verrà visualizzata una schermata del menu.
Passare alla fase 3.

3. Selezionare [Define New], quindi premere .
4. Nella schermata “Vector Dimension?” visualizzata, specificare le

dimensioni del vettore.

• Per specificare tre dimensioni, procedere come segue.
(1) Selezionare [Dimensions], quindi premere .
(2) Nel menu visualizzato, selezionare [3 Dimensions] e premere .

5. Dopo aver specificato le dimensioni, selezionare [Confirm] e premere
.

• Viene visualizzato l’editor vettoriale.
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6. Inserire gli elementi della variabile vettoriale.

1 2 3

7. Premere ,  o  per tornare alla schermata del calcolo vettoriale.

Nota

• Il contenuto delle variabili vettoriali viene conservato anche se si preme , si passa
a un’altra app o si spegne la calcolatrice. Eseguendo una delle seguenti operazioni, il
contenuto di tutte le variabili vettoriali verrà cancellato.
-  – [Reset] > [Settings & Data]
-  – [Reset] > [Initialize All]

Modifica dei dati delle variabili vettoriali

1. Quando viene visualizzata la schermata del calcolo vettoriale, premere
 per visualizzare la schermata dell’elenco delle variabili vettoriali.

2. Selezionare la variabile vettoriale (VctA, VctB, VctC o VctD) da
modificare, quindi premere .

3. Nel menu visualizzato, selezionare [Edit] e premere .
• Viene visualizzato l’editor vettoriale.

4. Con l’editor vettoriale, modificare gli elementi del vettore.
• Spostare il cursore nella cella contenente l’elemento da modificare,

inserire il nuovo valore, quindi premere .
5. Premere ,  o  per tornare alla schermata del calcolo vettoriale.

Copia del contenuto delle variabili vettoriali (o VctAns)

1. Visualizzare la schermata dell’editor vettoriale o la schermata VctAns
della variabile vettoriale da usare come origine per la copia.
• Per visualizzare l’editor vettoriale, eseguire le fasi 1, 2 e 3 descritte

nella sezione “Modifica dei dati delle variabili vettoriali” (pagina
131).

• Per visualizzare la schermata VctAns, utilizzare la seguente
procedura mentre è visualizzata la schermata di calcolo vettoriale.

 – [Vector] > [VctAns] 
2. Selezionare la destinazione della copia della variabile vettoriale.
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• Ad esempio, per copiarla in VctD, procedere come segue:  –
[Store] > [VctD].

• Viene visualizzato l’editor vettoriale con il contenuto della
destinazione della copia.

3. Premere ,  o  per tornare alla schermata del calcolo vettoriale.

Memoria delle risposte vettoriali (Vector Answer
Memory, VctAns)

Ogni volta che il risultato di un calcolo eseguito nell’app Vector è un
vettore, viene visualizzata la schermata VctAns con il risultato. Il risultato
sarà anche memorizzato in una variabile chiamata “VctAns”.

La variabile VctAns si può usare nei calcoli come descritto di seguito.
• Per inserire la variabile VctAns in un calcolo, procedere come segue:

– [Vector] > [VctAns].
• Premendo uno dei seguenti tasti mentre è visualizzata la schermata

VctAns, si passa automaticamente alla schermata del calcolo vettoriale,
con “VctAns” seguito dall’operatore o dalla funzione del tasto premuto:

, , , , , , , ( ), ( ).

Nota

• Il contenuto di VctAns viene conservato anche se si preme  o si spegne la
calcolatrice. Eseguendo una delle seguenti operazioni, il contenuto di VctAns verrà
cancellato.
- Ritorno alla schermata HOME e avvio di un’altra app della calcolatrice
- Esecuzione di  – [Reset] > [Settings & Data]
- Esecuzione di  – [Reset] > [Initialize All]

Esempi di calcolo vettoriale
Nei seguenti esempi si utilizza VctA = (1, 2) e VctB = (3, 4), e VctC = (2,
-1, 2).

Esempio 3: VctA • VctB (prodotto scalare)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Dot Product]

 – [Vector] > [VctB]

Nota

• Quando si calcola un prodotto scalare, i due vettori devono avere le stesse
dimensioni.
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Esempio 4: VctA × VctB (prodotto vettoriale)

 – [Vector] > [VctA]
 – [Vector] > [Vector Calc] > [Cross Product]

 – [Vector] > [VctB]

Nota

• Quando si calcola un prodotto vettoriale, i due vettori devono avere le stesse
dimensioni.

Esempio 5: determinare l’angolo formato da VctA e VctB, con tre cifre
decimali. (Number Format: Fix 3, Angle Unit: Degree)

 – [Vector] > [Vector Calc] > [Angle]
 – [Vector] > [VctA]

(,)  – [Vector] > [VctB]

Nota

• Quando si calcola un angolo formato da due vettori, i due vettori devono avere le
stesse dimensioni.

Esempio 6: normalizzare VctB

 – [Vector] > [Vector Calc] > [Unit Vector]
 – [Vector] > [VctB]

Esempio 7: ricavare i valori assoluti di VctC

 – [Numeric Calc] > [Absolute Value]
 – [Vector] > [VctC]
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Calcolo di proporzioni
L’app Ratio consente di determinare il valore di X nella proporzione A : B =
X : D (o A : B = C : X) quando sono noti i valori di A, B, C e D.

Procedura generale per eseguire calcoli di
proporzioni

Esempio 1: risolvere 3 : 8 = X : 12 per X
1. Premere , selezionare l’icona dell’app Ratio, quindi premere .
2. Nel menu visualizzato, selezionare [A:B=X:D] o [A:B=C:X].

• Qui vogliamo risolvere 3 : 8 = X : 12 per X; selezionare [A:B=X:D],
quindi premere .

3. Nell’editor dei coefficienti che viene visualizzato, inserire i valori del
coefficiente.
• Qui per i coefficienti inseriamo i seguenti valori: A = 3, B = 8, D = 12.

3 8 12

4. Dopo aver assegnato tutti i valori, premere .
• Viene visualizzata la soluzione (valore di X).

• Premere ,  o  per tornare all’editor dei coefficienti.

Nota

• Se si esegue un calcolo inserendo 0 come coefficiente, si verificherà un Math ERROR.
• La seguente procedura consente di reimpostare al valore 1 tutti i coefficienti dell’editor

dei coefficienti.
- Mentre è visualizzato l’editor dei coefficienti, premere , ,  o .
- Quando viene visualizzata una soluzione, premere  o .

• È possibile memorizzare in una variabile il risultato del calcolo visualizzato. Ad
esempio, eseguendo la seguente operazione mentre è visibile la schermata di cui
alla fase 4, il risultato del calcolo verrà memorizzato nella variabile A:  – [A=] >
[Store]. Per informazioni dettagliate sulle variabili, consultare la sezione “Variabili (A,
B, C, D, E, F, x, y, z)” (pagina 39).
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Per modificare il tipo di proporzione

1. Mentre è visualizzato l’editor dei coefficienti, premere .
2. Selezionare nel menu il tipo di proporzione.

Esempio di calcolo
Esempio 2: calcolare X nella proporzione 1 : 2 = X : 10

 – [Ratio] > [A:B=X:D]
1 2 10

Utilizzo della funzionalità Math Box
L’app Math Box ha le seguenti funzioni di supporto didattico.
Dice Roll: Dice Roll è una funzione che simula le probabilità coinvolte nel
lancio dei dadi.
Coin Toss: Coin Toss è una funzione che simula la probabilità coinvolte
nel lancio di una moneta.

Dice Roll
Dice Roll simula lanci di uno, due o tre dadi virtuali per il numero di
volte specificato. Per il risultato è possibile selezionare una delle seguenti
schermate.

Schermata List

Schermata Relative Freq
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Dice Roll – Procedura operativa generale

Esempio: simulare 100 lanci di due dadi. In questo esempio utilizziamo
per i risultati della simulazione la schermata Relative Freq, che mostra il
numero di occorrenze (frequenza) e le frequenze relative della differenza
numerica (0, 1, 2, 3, 4, 5) tra i due dadi a ogni lancio.

1. Premere , selezionare l’icona dell’app Math Box e premere .
• Viene visualizzato il menu Math Box.

2. Selezionare [Dice Roll] e premere .
• Viene visualizzata la schermata di inserimento dei parametri.

Dice: selezionare il numero di dadi: 1, 2 o 3.
Attempts: inserire il numero di lanci dei dadi (numero di prove): un
valore compreso tra 1 e 250.
Same Result: questa impostazione normalmente è in condizione Off
(impostazione predefinita iniziale). Per i dettagli, consultare la sezione
“Impostazioni Same Result” (pagina 139).

3. Selezionare ciascuna impostazione del menu e configurarla nel modo
desiderato.
(1) Selezionare [Dice] e premere . Nel menu visualizzato, selezionare

[2 Dice] e premere .
(2) Selezionare [Attempts] e premere . Nella schermata di

inserimento visualizzata, inserire 100, quindi premere .
Selezionare [Confirm] e premere .

(3) Lasciare l’impostazione [Same Result] su Off (impostazione
predefinita iniziale).

4. Dopo aver definito tutte le impostazioni desiderate, selezionare
[Execute], quindi premere .
• Viene visualizzata la schermata che mostra l’esecuzione della

simulazione, quindi il menu Result Type.

List: mostra l’elenco dei risultati di ciascun lancio (prova).*1
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Relative Freq: mostra il numero di occorrenze in riferimento ai risultati
del lancio*2 e alle frequenze relative.
*1 Con due dadi, il risultato di ogni lancio viene visualizzato insieme alla

somma e alla differenza per ciascun lancio. Con tre dadi, il risultato di
ogni lancio viene visualizzato insieme alla somma del lancio.

*2 Risultato (da 1 a 6) nel caso di un dado, somma (da 2 a 12) o
differenza (da 0 a 5) dei risultati nel caso di due dadi e somma (da 3 a
18) dei risultati nel caso di tre dadi.

5. Il menu Result Type consente di selezionare il formato di
visualizzazione dei risultati.
(1) Qui si vuole visualizzare il numero di occorrenze e le frequenze

relative; selezionare [Relative Freq] e premere .
• Verrà visualizzato il menu di selezione [Sum] o [Difference].

(2) Qui si vuole visualizzare la differenza dei risultati di ogni lancio:
selezionare [Difference] e premere .

• Il risultato della simulazione viene visualizzato nella schermata
Relative Freq.

(Il risultato varia a ogni esecuzione.)

• Per i dettagli sulla schermata dei risultati della simulazione,
consultare la sezione “Dice Roll – Schermata dei risultati”
(pagina 138).

6. Per visualizzare i risultati in un altro formato, visualizzare la schermata
dei risultati e premere .
• Si tornerà al menu Result Type, dove è possibile ripetere il passaggio

5 di questa procedura e cambiare il formato di visualizzazione.
7. Per una eseguire simulazione con impostazioni diverse, premere 

mentre è visualizzato il menu Result Type.
• Il risultato della simulazione verrà cancellato e si tornerà alla

schermata di inserimento dei parametri. Eseguire nuovamente la
procedura dal punto 3.

8. Per uscire da Dice Roll, premere  mentre è visualizzata la schermata
di inserimento dei parametri.
• Si tornerà al menu Math Box.

Nota

• Nella schermata Relative Freq è possibile memorizzare in una variabile il valore in una
cella della colonna Rel Fr. Ad esempio, con la seguente operazione nel passaggio 5 si
memorizza nella variabile A il valore presente nella prima riga della colonna “Rel Fr”:
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 – [A=] > [Store]. Per informazioni dettagliate sulle variabili, consultare la sezione
“Variabili (A, B, C, D, E, F, x, y, z)” (pagina 39).

Dice Roll – Schermata dei risultati

• Schermata List

(1) Ogni riga mostra il numero progressivo dei lanci. Ad esempio, 1 è il
primo lancio, 2 è il secondo lancio e così via.

(2) A, B e C indicano ciascuno dei dadi in uso. “Sum” è il risultato totale,
mentre “Diff” è la differenza tra i risultati di due dadi. Le colonne
visualizzate sul display dipendono dal numero di dadi utilizzati.
1 dado: solo la colonna A.
2 dadi: colonne A, B, Sum e Diff.
3 dadi: colonne A, B, C e Sum.

• Schermata Relative Freq

(1) Sum o Diff: mostra il risultato di un dado (Sum: da 1 a 6), la somma
dei risultati di due dadi (Sum: da 2 a 12) o la differenza (Diff: da 0 a
5) o la somma dei risultati di tre dadi (Sum: da 3 a 18).

(2) Freq: mostra il numero di occorrenze (frequenza) del risultato di
ciascun lancio.

(3) Rel Fr: mostra la frequenza relativa (frequenza divisa per il numero
di lanci) dei risultati dei lanci.

(4) Numero di prove
(5) Il valore della cella Rel Fr è evidenziato
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Impostazioni Same Result

Quando si esegue una simulazione Dice Roll o Coin Toss lasciando
il parametro Same Result alla sua impostazione predefinita iniziale
(Off), ogni esecuzione mostra un risultato (casuale) diverso. Se si
assegna all’impostazione Same Result un valore diverso da Off, i risultati
visualizzati saranno quelli determinati dalla calcolatrice. Le impostazioni
#1, #2 o #3 sono utili quando si vuole che tutte le calcolatrici utilizzate
dagli studenti di una classe visualizzino lo stesso risultato.

Nota

• Affinché più calcolatrici visualizzino lo stesso risultato, verificare che le seguenti
impostazioni siano identiche su tutte le calcolatrici.
- Numero di dadi o monete
- Numero di prove (lanci)
- Impostazione Same Result (#1, #2 o #3)

Coin Toss
Coin Toss simula lanci di una, due o tre monete virtuali per il numero di
volte specificato. Per il risultato è possibile selezionare una delle seguenti
schermate.

Schermata List

Schermata Relative Freq

Lo schermo mostra i risultati “testa” come  e i risultati “croce” come .

Coin Toss – Procedura operativa generale

Esempio: simulare 100 lanci di tre monete. In questo esempio utilizziamo
per i risultati della simulazione la schermata Relative Freq, che mostra il
numero di teste (0, 1, 2, 3) e le frequenze relative delle teste a ogni lancio.

1. Premere , selezionare l’icona dell’app Math Box e premere .
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• Viene visualizzato il menu Math Box.

2. Selezionare [Coin Toss], quindi premere .
• Viene visualizzata la schermata di inserimento dei parametri.

Coins: selezionare il numero di monete: 1, 2 o 3.
Attempts: inserire il numero di lanci di monete (numero di prove): un
valore compreso tra 1 e 250.
Same Result: questa impostazione normalmente è in condizione Off
(impostazione predefinita iniziale). Per i dettagli, consultare la sezione
“Impostazioni Same Result” (pagina 139).

3. Selezionare ciascuna impostazione del menu e configurarla nel modo
desiderato.
(1) Selezionare [Coins] e premere . Nel menu visualizzato,

selezionare [3 Coins] e premere .
(2) Selezionare [Attempts] e premere . Quando viene visualizzata

la schermata di inserimento, inserire 100 quindi premere .
Selezionare [Confirm] e premere .

(3) Lasciare l’impostazione [Same Result] su Off (impostazione
predefinita iniziale).

4. Dopo aver definito tutte le impostazioni desiderate, selezionare
[Execute], quindi premere .
• Viene visualizzata la schermata che mostra l’esecuzione della

simulazione, quindi il menu Result Type.

List: mostra un elenco di teste o croci*1 per ogni lancio (prova).
Relative Freq: mostra il numero di occorrenze del risultato “testa” per
ogni moneta*2 e le frequenze relative.
*1 Con due o tre monete, mostra il numero di monete che a ogni lancio

danno il risultato “testa”.
*2 Per due o tre monete. Con è una moneta, mostra la frequenza dei

risultati “testa” e “croce” e le frequenze relative.
5. Il menu Result Type consente di selezionare il formato di

visualizzazione dei risultati.
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Qui si vuole visualizzare il numero di occorrenze e le frequenze relative;
selezionare [Relative Freq] e premere .
• Il risultato della simulazione viene mostrato nella schermata Relative

Freq.

(Il risultato varia a ogni esecuzione.)

• Per i dettagli sulla schermata dei risultati della simulazione, consultare
la sezione “Coin Toss – Schermata dei risultati” (pagina 141).

6. Per visualizzare i risultati in un altro formato, visualizzare la schermata
dei risultati e premere .
• Si tornerà al menu Result Type, dove è possibile ripetere il passaggio

5 di questa procedura e cambiare il formato di visualizzazione.
7. Per una eseguire simulazione con impostazioni diverse, premere 

mentre è visualizzato il menu Result Type.
• Il risultato della simulazione verrà cancellato e si tornerà alla

schermata di inserimento dei parametri. Eseguire nuovamente la
procedura dal punto 3.

8. Per uscire da Coin Toss, premere  mentre è visualizzata la
schermata di inserimento dei parametri.
• Si tornerà al menu Math Box.

Nota

• Nella schermata Relative Freq è possibile memorizzare in una variabile il valore in una
cella della colonna Rel Fr. Ad esempio, con la seguente operazione nel passaggio 5 si
memorizza nella variabile A il valore presente nella prima riga della colonna “Rel Fr”:

 – [A=] > [Store].

Coin Toss – Schermata dei risultati

• Schermata List

(1) Ogni riga mostra il numero progressivo dei lanci. Ad esempio, 1 è il
primo lancio, 2 è il secondo lancio e così via.
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(2) A, B e C indicano ciascuna delle monete in uso. Quando si usano
due o tre monete, la colonna  a destra mostra il numero di monete
che hanno dato il risultato “testa”.

• Schermata Relative Freq

(1) Side: quando si utilizza una sola moneta, “ ” indica i risultati “testa”
e “ ” i risultati “croce”. Quando si utilizzano due o tre monete,
questa colonna mostra il numero di risultati “testa” (da 0 a 3).

(2) Freq: mostra il numero di occorrenze (frequenza) del risultato di
ciascun lancio.

(3) Rel Fr: mostra la frequenza relativa (frequenza divisa per il numero
di lanci) dei risultati dei lanci.

(4) Numero di prove
(5) Il valore della cella Rel Fr è evidenziato
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Informazioni tecniche

Errori
Ogni volta che per qualche motivo durante un calcolo si verifica un errore,
la calcolatrice visualizza un messaggio di errore.

Visualizzazione della posizione di un errore
Quando viene visualizzato un messaggio di errore, premendo ,  o 
si torna alla schermata immediatamente precedente alla visualizzazione
del messaggio. Il cursore si troverà nella posizione in cui si è verificato
l’errore, pronto per l’inserimento. Correggere il calcolo ed eseguirlo
nuovamente.

Esempio: errato inserimento di 14 ÷ 0 × 2 anziché di 14 ÷ 10 × 2.

14 0 2

 (o  o )

1

Messaggi di errore

Syntax ERROR

Causa:
• C’è un problema relativo al formato del calcolo che si sta eseguendo.

Azione:
• Correggere in base alle esigenze.

Math ERROR

Causa:
• Il risultato intermedio o finale del calcolo che si sta eseguendo non

rientra nell’intervallo di calcolo consentito.
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• Il valore inserito non rientra nell’intervallo di inserimento consentito
(soprattutto quando si lavora con le funzioni).

• Il calcolo che si sta eseguendo contiene un’operazione matematica
non valida, ad esempio una divisione per zero.

• Utilizzando un’app che non supporta i numeri complessi o mentre è
visualizzata una schermata che non consente l’inserimento di numeri
complessi, si è cercato di eseguire un calcolo che coinvolge una
variabile in cui è memorizzato un numero complesso.

Azione:
• Controllare i valori inseriti, ridurre il numero di cifre e riprovare.
• Quando si utilizza una variabile come argomento di una funzione,

verificare che il valore della variabile rientri nell’intervallo consentito
per la funzione.

• Per eseguire un calcolo che coinvolge una variabile in cui è
memorizzato un numero complesso utilizzando un’app che non
supporta i numeri complessi o mentre è visualizzata una schermata
che non consente l’inserimento di numeri complessi, modificare in un
numero reale il valore memorizzato nella variabile.

Stack ERROR

Causa:
• Durante il calcolo è stata superata la capacità dello stack numerico o

dello stack dei comandi.
• Durante il calcolo è stata superata la capacità dello stack della

matrice o del vettore.
Azione:
• Semplificare l’espressione affinché non superi la capacità dello stack.
• Provare a dividere il calcolo in due o più parti.

Argument ERROR

Causa:
• C’è un problema relativo all’argomento del calcolo che si sta

eseguendo.
Azione:
• Correggere in base alle esigenze.

Dimension ERROR (solo app Matrix e Vector)

Causa:
• Si sta cercando di eseguire un calcolo con matrici o vettori le cui

dimensioni non consentono questo tipo di calcolo.
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Azione:
• Controllare le dimensioni delle matrici o dei vettori per verificare che

siano compatibili con il calcolo.

Variable ERROR (solo operazione Solver dell’app Equation)

Causa:
• Tentativo di eseguire Solver per un’espressione inserita senza

variabili.
Azione:
• Inserire un’espressione contenente una variabile.

Cannot Solve (solo operazione Solver dell’app Equation)

Causa:
• La calcolatrice non ha trovato una soluzione.

Azione:
• Verificare la presenza di errori nell’equazione inserita.
• Inserire per la variabile di soluzione un valore che si avvicini alla

soluzione prevista e riprovare.

Range ERROR

Causa (app Table):
• Tentativo di generare nell’app Table una tabella numerica le cui

condizioni determinano il superamento del numero di righe consentito.
Azione:
• Ridurre l’intervallo di calcolo della tabella modificando i valori Start,

End e Step, quindi riprovare.
Causa (app Spreadsheet):
• Durante l’inserimento in batch nell’app Spreadsheet, il valore di

Range non rientra nell’intervallo consentito o è un nome di cella
inesistente.

Azione:
• Inserire per il parametro Range un nome di cella compreso

nell’intervallo da A1 a E45, con la seguente sintassi: “A1:A1”.
Causa (app Math Box):
• Il valore Attempts (numero di prove) inserito per Dice Roll o Coin Toss

non rientra nell’intervallo consentito o non è un valore intero.
Azione:
• Inserire un valore di Attempts intero che rientri nell’intervallo

consentito.

145



Time Out

Causa (calcolo differenziale o integrale):
• Il calcolo del differenziale o integrale attuale finisce senza che la

condizione finale sia soddisfatta.
Azione:
• Provare ad aumentare il valore di tol. Nota: in questo modo si riduce

anche la precisione della soluzione.
Causa (app Distribution):
• Il calcolo di distribuzione attuale finisce senza che la condizione finale

sia soddisfatta.
Azione:
• Modificare il valore di ciascun parametro.

Circular ERROR

Causa (operazione f(x) e g(x)):
• Si verifica un riferimento circolare in una funzione composta registrata

(“Registrazione di una funzione composta” (pagina 65)).
Azione:
• Non è possibile inserire g(x) in f(x) e f(x) in g(x) contemporaneamente.

Causa (app Spreadsheet):
• È presente un riferimento circolare nel foglio di calcolo (ad esempio

“=A1” nella cella A1).
Azione:
• Modificare il contenuto delle celle per rimuovere i riferimenti circolari.

Memory ERROR (solo app Spreadsheet)　

Causa:
• I dati che si sta cercando di inserire superano la capacità di

inserimento consentita (1.700 byte).
• I dati che si sta cercando di inserire generano una catena di

riferimenti consecutivi alle celle (ad esempio la cella A2 a cui fa
riferimento la cella A1, la cella A3 a cui fa riferimento la cella A2… e
così via). Questo tipo di inserimento determina sempre questo errore,
anche se la capacità di memoria (1.700 byte) non viene superata.

Azione:
• Eliminare i dati non necessari e ripetere l’inserimento dei dati.
• Ridurre il più possibile i dati che generano una catena di riferimenti

consecutivi alle celle.
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Not Defined

Causa (operazione f(x) e g(x)):
• Si è cercato di calcolare f(x) o g(x) senza definire f(x)/g(x).

Azione:
• Definire f(x) o g(x) prima di calcolare f(x)/g(x).

Causa (app Matrix e Vector):
• La matrice o il vettore inseriti per un calcolo è non hanno dimensioni

specificate.
Azione:
• Specificare le dimensioni della matrice o del vettore, quindi ripetere il

calcolo.

Prima di ipotizzare
un malfunzionamento della
calcolatrice…
Nota: prima di eseguire questi passaggi è opportuno creare delle copie
separate dei dati importanti.
1. Controllare l’espressione per verificare che non contenga errori.
2. Utilizzare l’app corretta per il tipo di calcolo da eseguire.

• Per verificare l’app attualmente in uso, premere . Verrà evidenziata
l’icona dell’app attualmente in uso.

3. Se la procedura descritta sopra non consente di risolvere il problema,
premere il tasto .
• In questo modo la calcolatrice eseguirà una routine per controllare

se le funzioni di calcolo funzionano correttamente. Se viene rilevata
un’anomalia, la calcolatrice inizializza automaticamente l’app e
cancella il contenuto della memoria.

4. Ripristinare le impostazioni predefinite iniziali della calcolatrice (tranne
di Contrast e Auto Power Off) con la seguente procedura.
(1) Premere , selezionare l’icona dell’app, quindi premere .
(2) Premere , quindi selezionare [Reset] > [Settings & Data] > [Yes].

Sostituzione della batteria
Se subito dopo l’accensione viene visualizzata la seguente schermata, la
batteria è scarica.
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La batteria scarica è indicata anche dalla minore luminosità del display,
anche se il contrasto è regolato correttamente, o dalla mancata
visualizzazione delle cifre all’accensione della calcolatrice.
In questi casi, o se viene visualizzata la schermata precedente, sostituire
la batteria con una nuova.

Importante!

• Togliendo la batteria, tutto il contenuto della memoria della calcolatrice viene
cancellato.

1. Premere (OFF) per spegnere la calcolatrice.
• Per evitare di accendere accidentalmente la calcolatrice durante

la sostituzione della batteria, applicare alla parte anteriore di
quest’ultima il coperchio anteriore.

2. Rimuovere il coperchio della batteria, rimuovere la batteria, quindi
inserire una nuova batteria posizionando correttamente il polo positivo
(+) e quello negativo (−), come mostrato nell’immagine.

3. Reinstallare il coperchio della batteria.
4. Premere  per accendere la calcolatrice.
5. Inizializzare la calcolatrice.

(1) Premere , selezionare l’icona dell’app, quindi premere .
(2) Premere , quindi selezionare [Reset] > [Initialize All] > [Yes].
• Non saltare i passaggi riportati qui sopra!
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Sequenza delle priorità di calcolo
La calcolatrice esegue i calcoli in base a una sequenza di priorità.

• Di base, i calcoli vengono eseguiti da sinistra a destra.
• Le espressioni tra parentesi hanno la priorità massima.
• Di seguito è illustrata la sequenza delle priorità per ogni singolo

comando.

1 Espressioni tra parentesi

2
Funzioni con parentesi (sin(, log(, f(, g(, ecc., funzioni che
hanno un argomento a destra, funzioni che richiedono una
parentesi di chiusura dopo l’argomento)

3
Funzioni che vengono dopo il valore inserito (x2, x3, x-1, x!,
°” ”, °, r, g, %, t), simboli scientifici (m, μ, n, p, f, k, M, G, T,
P, E), potenze ( ), radici ( )

4 Frazioni

5 Segno negativo ((-)), Base Prefix (d, h, b, o)

6
Comandi di conversione delle unità (cm in ecc.), valori
stimati dell’app Statistics (x̂, ŷ, x̂1, x̂2)

7 Moltiplicazione in cui il segno di moltiplicazione è omesso

8
Permutazioni (nPr), combinazioni (nCr), coordinate polari
numeri complessi (∠)

9 Prodotti scalari (•)

10 Moltiplicazioni (×), divisioni (÷)

11 Addizioni (+), sottrazioni (−)

12 operatore logico “and”

13 operatori logici “or”, “xor”, “xnor”

Se un calcolo contiene un valore negativo, può essere necessario
racchiuderlo tra parentesi. Per calcolare il quadrato del valore -2, ad
esempio, si dovrà inserire: (-2)2. Questo perché x2 è una funzione
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preceduta da un valore (Priorità 3, sopra), la cui priorità è maggiore di
quella del segno negativo, che è un prefisso (Priorità 5).

Esempio:
((-))2     -22 = -4

((-))2  (-2)2 = 4

Intervalli di calcolo, numero di cifre e
precisione
L’intervallo di calcolo, il numero di cifre utilizzate per i calcoli interni e la
precisione del calcolo dipendono dal tipo di calcolo che si esegue.

Intervallo di calcolo e precisione

Intervallo di calcolo Da ±1 × 10-99 a ±9,999999999 × 1099 o 0

Numero di cifre per i calcoli
interni

23 cifre

Precisione

In generale ±1 alla 10ᵃ cifra per un
singolo calcolo. La precisione per la
visualizzazione esponenziale è ±1 alla
cifra meno significativa. Nel caso di calcoli
consecutivi, gli errori sono cumulativi.

Intervalli di calcolo, numero di cifre e precisione
per le funzioni

Funzioni Intervallo di inserimento

sinx
cosx

Degree 0 ≤ |x| < 9 × 109

Radian 0 ≤ |x| < 157079632,7

Gradian 0 ≤ |x| < 1 × 1010
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tanx

Degree
Come per sinx, tranne
quando |x| = (2n - 1) × 90.

Radian
Come per sinx, tranne
quando |x| = (2n - 1) × π/2.

Gradian
Come per sinx, tranne
quando |x| = (2n - 1) × 100.

sin-1x, cos-1x 0 ≤ |x| ≤ 1

tan-1x 0 ≤ |x| ≤ 9,999999999 × 1099

sinhx, coshx 0 ≤ |x| ≤ 230,2585092

sinh-1x 0 ≤ |x| ≤ 4,999999999 × 1099

cosh-1x 1 ≤ x ≤ 4,999999999 × 1099

tanhx 0 ≤ |x| ≤ 9,999999999 × 1099

tanh-1x 0 ≤ |x| ≤ 9,999999999 × 10-1

logx, lnx 0 < x ≤ 9,999999999 × 1099

10x -9,999999999 × 1099 ≤ x ≤ 99,99999999

√x 0 ≤ x < 1 × 10100

x2 |x| < 1 × 1050

x-1 |x| < 1 × 10100; x ≠ 0

x! 0 ≤ x ≤ 69 (x è un numero intero)

nPr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r sono numeri interi)
1 ≤ {n!/(n - r)!} < 1 × 10100

nCr
0 ≤ n < 1 × 1010, 0 ≤ r ≤ n (n, r sono numeri interi)
1 ≤ n!/r! < 1 × 10100 o 1 ≤ n!/(n - r)! < 1 × 10100

Pol(x, y)
|x|, |y| ≤ 9,999999999 × 1099

√x2 + y2 ≤ 9,999999999 × 1099

Rec(r, θ)
0 ≤ r ≤ 9,999999999 × 1099

θ: Come per sinx
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a°b”c”
|a|, b, c < 1 × 10100; 0 ≤ b, c
Il valore dei secondi visualizzati è soggetto a un
errore di ±1 alla seconda cifra decimale.

a°b”c” = x

0°0’0” ≤ |x| ≤ 9999999°59’59”
Un valore sessagesimale esterno all’intervallo
indicato viene automaticamente trattato come un
valore decimale.

xy

x > 0: -1 × 10100 < ylogx < 100
x = 0: y > 0

x < 0: y = n, m
2n + 1 (m, n sono numeri interi)

Tuttavia: -1 × 10100 < ylog |x| < 100

x
√y

y > 0: x ≠ 0, -1 × 10100 < 1/x logy < 100
y = 0: x > 0

y < 0: x = 2n + 1, 2n + 1
　 m　

 (m ≠ 0; m, n sono numeri

interi)
Tuttavia: -1 × 10100 < 1/x log |y| < 100

a b/c
Il totale di numero intero, numeratore e
denominatore non deve superare le 10 cifre
(compreso il simbolo del separatore).

RanInt#(a, b) a < b; |a|, |b| < 1 × 1010; b - a < 1 × 1010

• La precisione è fondamentalmente la stessa descritta nella sezione
“Intervallo di calcolo e precisione”, sopra.

• Le funzioni di tipo xy, 
x
√y, x!, nPr, nCr richiedono calcoli interni consecutivi

che possono determinare l’accumulo degli errori che si verificano a ogni
calcolo.

• L’errore è cumulativo e tende ad aumentare in prossimità dei punti di
discontinuità e dei punti di flesso delle funzioni.

• L’intervallo dei risultati di calcolo visualizzabili in formato π quando per
l’impostazione Input/Output del menu SETTINGS si seleziona il valore
MathI/MathO è |x| < 106. Tuttavia l’errore nei calcoli interni può impedire
la visualizzazione di alcuni risultati in formato π. Può anche causare
la visualizzazione in formato π dei risultati del calcolo che dovrebbero
apparire in formato decimale.

152



Specifiche

fx-570CW
Requisiti di alimentazione:
Una batteria formato AAA R03

Durata approssimativa della batteria:
2 anni (ipotizzando un’ora di utilizzo al giorno)

Potenza assorbita:
0,0008 W

Temperatura di esercizio:
Da 0 °C a 40 °C

Dimensioni:
13,8 (A) × 77 (L) × 162 (P) mm

Peso approssimativo:
100 g, batteria inclusa

fx-991CW
Requisiti di alimentazione:
Cella solare integrata; una batteria a bottone LR44

Durata approssimativa della batteria:
2 anni (ipotizzando un’ora di utilizzo al giorno)

Temperatura di esercizio:
Da 0 °C a 40 °C

Dimensioni:
10,7 (A) × 77 (L) × 162 (P) mm

Peso approssimativo:
95 g, batteria inclusa
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Domande frequenti

Domande frequenti
■ Come modificare in formato decimale un risultato frazionario

ottenuto mediante un’operazione di divisione?
→ Mentre il risultato del calcolo frazionario è visibile, premere  e

selezionare [Decimal], oppure premere ( ). Per visualizzare
inizialmente i risultati del calcolo come valori decimali, modificare
l’impostazione Input/Output del SETTINGS in MathI/DecimalO.

■ Qual è la differenza tra la memoria Ans e la memoria delle variabili?
→ Entrambi i tipi di memoria fungono Da “contenitori” per memorizzare

temporaneamente un singolo valore.
Memoria Ans: memorizza il risultato dell’ultimo calcolo eseguito.
Questa memoria si usa per trasferire il risultato di un calcolo a quello
successivo.
Variabili: questa memoria è utile quando si vuole utilizzare lo stesso
valore diverse volte in uno o più calcoli.

■ Come trovare in questa calcolatrice una funzione che utilizzavo con
un vecchio modello di calcolatrice CASIO?

→ È possibile accedere alle funzioni di questa calcolatrice tramite il menu
CATALOG, visualizzabile premendo . Per i dettagli, consultare le
seguenti sezioni.
“Utilizzo del menu CATALOG” (pagina 27)
“Calcoli avanzati” (pagina 49)

■ Con un vecchio modello di calcolatrice CASIO, per modificare il
formato di visualizzazione dei risultati del calcolo premevo .
Come posso farlo con questa calcolatrice?

→ Mentre il risultato del calcolo è visibile, premere . Nel menu
visualizzato, selezionare il formato di visualizzazione desiderato. Per
informazioni dettagliate, consultare la sezione “Modifica del formato
dei risultati dei calcoli” (pagina 42).

■ Come posso scoprire quale app della calcolatrice sto utilizzando
attualmente?

→ Premere . L’icona dell’app attualmente in uso verrà evidenziata.

■ Come posso calcolare sin2 x

→ Per calcolare, ad esempio, sin2 30 = 1
4 , eseguire il seguente calcolo.
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30

■ Perché non posso inserire (i) o calcolare un numero
complesso?

→ L’app Calculate non è utilizzabile per inserire i o per i calcoli di numeri
complessi. Per tali calcoli, utilizzare l’app Complex.

■ Perché all’accensione della calcolatrice viene visualizzata l’icona
della batteria ( )?

→ L’icona della batteria indica che la batteria è scarica. Se viene
visualizzata questa icona, sostituire la batteria appena possibile.
Per i dettagli sulla sostituzione della batteria, consultare la sezione
“Sostituzione della batteria” (pagina 147).

■ Come posso ripristinare le impostazioni predefinite iniziali della
calcolatrice?

→ La seguente procedura consente inizializzare le impostazioni della
calcolatrice (tranne Contrast e Auto Power Off).
(1) Premere , selezionare l’icona dell’app, quindi premere .
(2) Premere , quindi selezionare [Reset] > [Settings & Data] > [Yes].
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